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Copyright Notice 
Copyright © 1999 - 2010

Sterling Commerce, Inc.

ALL RIGHTS RESERVED

STERLING COMMERCE SOFTWARE 

***TRADE SECRET NOTICE*** 

THE STERLING COMMERCE SOFTWARE DESCRIBED BY THIS DOCUMENTATION ("STERLING COMMERCE 
SOFTWARE") IS THE CONFIDENTIAL AND TRADE SECRET PROPERTY OF STERLING COMMERCE, INC., ITS 
AFFILIATED COMPANIES OR ITS OR THEIR LICENSORS, AND IS PROVIDED UNDER THE TERMS OF A 
LICENSE AGREEMENT. NO DUPLICATION OR DISCLOSURE WITHOUT PRIOR WRITTEN PERMISSION. 
RESTRICTED RIGHTS.

This documentation, the Sterling Commerce Software it describes, and the information and know-how 
they contain constitute the proprietary, confidential and valuable trade secret information of Sterling 
Commerce, Inc., its affiliated companies or its or their licensors, and may not be used for any 
unauthorized purpose, or disclosed to others without the prior written permission of the applicable 
Sterling Commerce entity. This documentation and the Sterling Commerce Software that it describes 
have been provided pursuant to a license agreement that contains prohibitions against and/or 
restrictions on their copying, modification and use. Duplication, in whole or in part, if and when 
permitted, shall bear this notice and the Sterling Commerce, Inc. copyright notice. 

U.S. GOVERNMENT RESTRICTED RIGHTS. This documentation and the Sterling Commerce Software it 
describes are "commercial items" as defined in 48 C.F.R. 2.101. As and when provided to any agency or 
instrumentality of the U.S. Government or to a U.S. Government prime contractor or a subcontractor at 
any tier ("Government Licensee"), the terms and conditions of the customary Sterling Commerce 
commercial license agreement are imposed on Government Licensees per 48 C.F.R. 12.212 or 227.7202 
through 227.7202-4, as applicable, or through 48 C.F.R. § 52.244-6. 

This Trade Secret Notice, including the terms of use herein is governed by the laws of the State of Ohio, 
USA, without regard to its conflict of laws provisions. If you are accessing the Sterling Commerce 
Software under an executed agreement, then nothing in these terms and conditions supersedes or 
modifies the executed agreement.

Sterling Commerce, Inc.
4600 Lakehurst Court
Dublin, Ohio 43016-2000

Copyright © 1999 - 2010



Third-Party Software

Portions of the Sterling Commerce Software may include products, or may be distributed on the same 
storage media with products, ("Third Party Software") offered by third parties ("Third Party Licensors"). 
Sterling Commerce Software may include Third Party Software covered by the following copyrights: 
Copyright © 2006-2008 Andres Almiray. Copyright © 1999-2005 The Apache Software Foundation. Erik 
Arvidsson. Copyright © 2008 Azer Koçulu http://azer.kodfabrik.com. Copyright © Einar Lielmanis, 
einars@gmail.com. Copyright © 2006 John Reilly (www.inconspicuous.org) and Copyright © 2002 
Douglas Crockford (www.crockford.com). Copyright © 2009 John Resig, http://jquery.com/. Copyright © 
2006-2008 Json-lib. Copyright © 2001 LOOX Software, Inc. Copyright © 2003-2008 Luck Consulting Pty. 
Ltd. Copyright 2002-2004 © MetaStuff, Ltd. Copyright © 2009 Michael Mathews micmath@gmail.com. 
Copyright © 1999-2005 Northwoods Software Corporation. Copyright © Microsoft Corp. 1981-1998. 
Purple Technology, Inc. Copyright © 2004-2008 QOS.ch. Copyright © 2005 Sabre Airline Solutions. 
Copyright © 2004 SoftComplex, Inc. Copyright © 2000-2007 Sun Microsystems, Inc. Copyright © 2001 
VisualSoft Technologies Limited. Copyright © 2001 Zero G Software, Inc. All rights reserved by all listed 
parties. 

The Sterling Commerce Software is distributed on the same storage media as certain Third Party 
Software covered by the following copyrights: Copyright © 1999-2006 The Apache Software Foundation. 
Copyright © 2001-2003 Ant-Contrib project. Copyright © 1998-2007 Bela Ban. Copyright © 2005 
Eclipse Foundation. Copyright © 2002-2006 Julian Hyde and others. Copyright © 1997 ICE Engineering, 
Inc./Timothy Gerard Endres. Copyright 2000, 2006 IBM Corporation and others. Copyright © 1987-2006 
ILOG, Inc. Copyright © 2000-2006 Infragistics. Copyright © 2002-2005 JBoss, Inc. Copyright LuMriX.net 
GmbH, Switzerland. Copyright © 1998-2009 Mozilla.org. Copyright © 2003-2009 Mozdev Group, Inc. 
Copyright © 1999-2002 JBoss.org. Copyright © 2007, the OWASP Foundation. Copyright Raghu K, 2003. 
Copyright © 2004 David Schweinsberg. Copyright © 2005-2006 Darren L. Spurgeon. Copyright © 
2005-2008 Sam Stephenson. Copyright © S.E. Morris (FISH) 2003-04. Copyright © 1998 Regents of the 
University of California. Copyright © 2006 VisualSoft Technologies. Copyright © 2002-2009 Zipwise 
Software. All rights reserved by all listed parties.

Third Party Software which is included, or are distributed on the same storage media with, the Sterling 
Commerce Software where use, duplication, or disclosure by the United States government or a 
government contractor or subcontractor, are provided with RESTRICTED RIGHTS under Title 48 CFR 
2.101, 12.212, 52.227-19, 227.7201 through 227.7202-4, DFAR 252.227-7013(c) (1) (ii) and (2), DFAR 
252.227-7015(b)(6/95), DFAR 227.7202-3(a), FAR 52.227-14(g)(2)(6/87), and FAR 52.227-19(c)(2) 
and (6/87) as applicable.      

Additional information regarding certain Third Party Software is located at installdir/SCI_License.txt. 

Some Third Party Licensors also provide license information and/or source code for their software via 
their respective links set forth below:

http://danadler.com/jacob/

http://www.dom4j.org

This product includes software developed by the Apache Software Foundation (http://www.apache.org). 
This product includes software developed by the Ant-Contrib project 
(http://sourceforge.net/projects/ant-contrib). This product includes software developed by the JDOM 
Project (http://www.jdom.org/). This product includes code licensed from RSA Data Security (via Sun 
Microsystems, Inc.). Sun, Sun Microsystems, the Sun Logo, Java, JDK, the Java Coffee Cup logo, 
JavaBeans, JDBC, JMX and all JMX based trademarks and logos are trademarks or registered trademarks 
of Sun Microsystems, Inc. All other trademarks and logos are trademarks of their respective owners.

THE APACHE SOFTWARE FOUNDATION SOFTWARE

The Sterling Commerce Software is distributed with or on the same storage media as the following 
software products (or components thereof) and java source code files: Xalan version 2.5.2, Cookie.java, 
Header.java, HeaderElement.java, HttpException.java, HttpState.java, NameValuePair.java, 
CronTimeTrigger.java, DefaultTimeScheduler.java, PeriodicTimeTrigger.java, Target.java, 
TimeScheduledEntry.java, TimeScheduler.java, TimeTrigger.java, Trigger.java, BinaryHeap.java, 

http://danadler.com/jacob/
http://www.dom4j.org
http://www.apache.org
http://www.apache.org
http://sourceforge.net/projects/ant-contrib
http://azer.kodfabrik.com
http://jquery.com/
http://www.jdom.org/
www.inconspicuous.org
www.crockford.com


PriorityQueue.java, SynchronizedPriorityQueue.java, GetOpt.java, GetOptsException.java, 
IllegalArgumentException.java, MissingOptArgException.java (collectively,  "Apache 1.1 Software").   
Apache 1.1 Software is free software which is distributed under the terms of the following license:

License Version 1.1

Copyright 1999-2003 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

2. Redistribution in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.

3.The end-user documentation included with the redistribution, if any, must include the following 
acknowledgement: "This product includes software developed by the Apache Software Foundation 
(http://www.apache.org)." Alternatively, this acknowledgement may appear in the software itself, if and 
whenever such third-party acknowledgements normally appear.

4.The names  "Commons", "Jakarta", "The Jakarta Project", "HttpClient", "log4j", "Xerces "Xalan", 
"Avalon", "Apache Avalon", "Avalon Cornerstone", "Avalon Framework", "Apache" and "Apache Software 
Foundation" must not be used to endorse or promote products derived from this software without 
specific prior written permission. For written permission, please contact apache@apache.org.

5.Products derived from this software may not be called "Apache", nor may "Apache" appear in their 
name, without the prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY  EXPRESS OR IMIPLIED WARRANTIES, INCLUDING ANY 
IMPLIED WARRANTY OF MERCHANTIBILITY, AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTIAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache 
Software Foundation. The GetOpt.java, GetOptsException.java, IlligalArgumentException.java and 
MissingOptArgException.java software was originally based on software copyright © 2001, Sun 
Microsystems, http://www.sun.com. For more information on the Apache Software Foundation, please s

The preceding license only applies to the Apache 1.1 Software and does not apply to the Sterling 
Commerce Software or to any other Third Party Software.

The Sterling Commerce Software is also distributed with or on the same storage media as the following 
software products (or components thereof): Ant, Antinstaller, Apache File Upload Package, Apache 
Commons Beans, Apache Commons BetWixt, Apache Commons Collection, Apache Commons Digester, 
Apache Commons IO, Apache Commons Lang., Apache Commons Logging, Apache Commons Net, 
Apache Jakarta Commons Pool, Apache Jakarta ORO, Lucene, Xerces version 2.7, Apache Log4J, Apache 
SOAP, Apache Struts and Apache Xalan 2.7.0, (collectively,  "Apache 2.0 Software"). Apache 2.0 
Software is free software which is distributed under the terms of the Apache License Version 2.0. A copy 
of License Version 2.0 is found in the following directory files for the individual pieces of the Apache 2.0 
Software: installdir/jar/commons_upload/1_0/ CommonsFileUpload_License.txt, 
installdir/jar/jetspeed/1_4/RegExp_License.txt, 
 installdir/ant/Ant_License.txt
<install>/jar/antInstaller/0_8/antinstaller_License.txt
<install>/jar/commons_beanutils/1_7_0/commons-beanutils.jar (/META-INF/LICENSE.txt)
<install>/jar/commons_betwixt/0_8/commons-betwixt-0.8.jar (/META-INF/LICENSE.txt)
<install>/jar/commons_collections/3_2/LICENSE.txt
<install>/jar/commons_digester/1_8/commons-digester-1.8.jar (/META-INF/LICENSE.txt)

http://www.sun.com
http://www.apache.org


<install>/jar/commons_io/1_4/LICENSE.txt
<install>/jar/commons_lang/2_1/Commons_Lang_License.txt
<install>/jar/commons_logging/1_0_4/commons-logging-1.0.4.jar (/META-INF/LICENSE.txt)
<install>/jar/commons_net/1_4_1/commons-net-1.4.1.jar (/META-INF/LICENSE.txt)
<install>/jar/smcfs/9.0/lucene-core-2.4.0.jar (/META-INF/LICENSE.txt)
<install>/jar/struts/2_0_11/struts2-core-2.0.11.jar (./LICENSE.txt)
<install>/jar/mesa/gisdav/WEB-INF/lib/Slide_License.txt
<install>/mesa/studio/plugins/xerces_2.7_license.txt
<install>/jar/commons_pool/1_2/Commons_License.txt
<install>/jar/jakarta_oro/2_0_8/JakartaOro_License.txt
<install>/jar/log4j/1_2_15/LOG4J_License.txt
<install>/jar/xalan/2_7/Xalan_License.txt
<install>/jar/soap/2_3_1/Apache_SOAP_License.txt

Unless otherwise stated in a specific directory, the Apache 2.0 Software was not modified.  Neither the 
Sterling Commerce Software, modifications, if any, to Apache 2.0 Software, nor other Third Party Code is 
a Derivative Work or a Contribution as defined in License Version 2.0. License Version 2.0 applies only to 
the Apache 2.0 Software which is the subject of the specific directory file and does not apply to the 
Sterling Commerce Software or to any other Third Party Software. License Version 2.0 includes the 
following provision:

"Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each 
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS 
OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of 
TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are 
solely responsible for determining the appropriateness of using or redistributing the Work and assume 
any risks associated with Your exercise of permissions under this License." 

NOTICE file corresponding to the section 4 d of the Apache License, Version 2.0, in this case for the 
Apache Ant distribution.   Apache Ant   Copyright 1999-2008 The Apache Software Foundation.   This 
product includes software developed by The Apache Software Foundation (http://www.apache.org/). This 
product includes also software developed by:

     - the W3C consortium (http://www.w3c.org)
     - the SAX project (http://www.saxproject.org)

The <sync> task is based on code Copyright © 2002, Landmark Graphics Corp that has been kindly 
donated to the Apache Software Foundation.

Portions of this software were originally based on the following:

     - software copyright © 1999, IBM Corporation., http://www.ibm.com.
     - software copyright © 1999, Sun Microsystems., http://www.sun.com.
     - voluntary contributions made by Paul Eng on behalf of the Apache Software Foundation that were 
originally developed at iClick, Inc., software copyright © 1999.

NOTICE file corresponding to the section 4 d of the Apache License, Version 2.0, in this case for the 
Apache Lucene distribution. Apache Lucene Copyright 2006 The Apache Software Foundation. This 
product includes software developed by The Apache Software Foundation (http://www.apache.org/).    
The snowball stemmers in contrib/snowball/src/java/net/sf/snowball were developed by Martin Porter 
and Richard Boulton. The full snowball package is available from http://snowball.tartarus.org/

Ant-Contrib Software
The Sterling Commerce Software is distributed with or on the same storage media as the Anti-Contrib 
software (Copyright © 2001-2003 Ant-Contrib project. All rights reserved.) (the "Ant-Contrib Software"). 
The Ant-Contrib Software is free software which is distributed under the terms of the following license:

The Apache Software License, Version 1.1

Copyright © 2001-2003 Ant-Contrib project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 

http://www.apache.org/
http://www.w3c.org
http://www.saxproject.org
http://www.ibm.com
http://www.sun.com
http://www.apache.org/
http://snowball.tartarus.org/


that the following conditions are met:

1.Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

2.Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following 
acknowledgement:

      "This product includes software developed by the Ant-Contrib project 
(http://sourceforge.net/projects/ant-contrib)."

Alternately, this acknowledgement may appear in the software itself, if and wherever such third-party 
acknowledgements normally appear.

 4. The name Ant-Contrib must not be used to endorse or promote products derived from this software 
without prior written permission. For written permission, please contact 
ant-contrib-developers@lists.sourceforge.net. 

 5. Products derived from this software may not be called "Ant-Contrib" nor may "Ant-Contrib" appear in 
their names without prior written permission of the Ant-Contrib project.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE ANT-CONTRIB PROJECT OR ITS 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

The preceding license only applies to the Ant-Contrib Software and does not apply to the Sterling 
Commerce Software or to any other Third Party Software.

ANTISAMY SOFTWARE

The Sterling Commerce Software is distributed with or on the same storage media as the AntiSamy 
software (Copyright © 1998 Regents of the University of California. All rights reserved.) (the "AntiSamy 
Software"). The AntiSamy Software is free software which is distributed under the terms of the following 
license: 

Copyright © 1998, Regents of the University of California

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of the <ORGANIZATION> nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 

http://sourceforge.net/projects/ant-contrib


THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

COOLBUTTONS SOFTWARE

The Sterling Commerce Software is also distributed with or on the same storage media as Coolbuttons.js  
("Coolbuttons Software"), which is subject to the following license:

This Button Script was designed by Erik Arvidsson for WebFX. For more info and examples see: 
http://webfx.eae.net or send email to erik@eae.net. Feel free to use this code as long as this disclaimer 
is intact. 

The preceding license only applies to the Coolbuttons Software and does not apply to the Sterling 
Commerce Software, or any other Third Party Software. 

DOM4J Software

The Sterling Commerce Software is distributed with or on the same storage media as the Dom4h 
Software which is free software distributed under the terms of the following license:

Redistribution and use of this software and associated documentation ("Software"), with or without 
modification, are permitted provided that the following conditions are met: 

1.Redistributions of source code must retain copyright statements and notices. Redistributions must also 
contain a copy of this document. 

2.Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

3.The name "DOM4J" must not be used to endorse or promote products derived from this Software 
without prior written permission of MetaStuff, Ltd. For written permission, please contact 
dom4j-info@metastuff.com. 

4.Products derived from this Software may not be called "DOM4J" nor may "DOM4J" appear in their 
names without prior written permission of MetaStuff, Ltd. DOM4J is a registered trademark of MetaStuff, 
Ltd. 

5.Due credit should be given to the DOM4J Project - http://www.dom4j.org 

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS ``AS IS'' AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Copyright 2001-2004 © MetaStuff, Ltd. All Rights Reserved. 

The preceding license only applies to the Dom4j Software and does not apply to the Sterling Commerce 
Software, or any other Third Party Software. 

http://webfx.eae.net
http://www.dom4j.org


THE ECLIPSE SOFTWARE FOUNDATION

The Sterling Commerce Software is also distributed with or on the same storage media as the following 
software: 

com.ibm.icu.nl1_3.4.4.v200606220026.jar, org.eclipse.ant.core.nl1_3.1.100.v200606220026.jar, 
org.eclipse.ant.ui.nl1_3.2.0.v200606220026.jar, org.eclipse.compare.nl1_3.2.0.v200606220026.jar, 
org.eclipse.core.boot.nl1_3.1.100.v200606220026.jar, 
org.eclipse.core.commands.nl1_3.2.0.v200606220026.jar, 
org.eclipse.core.contenttype.nl1_3.2.0.v200606220026.jar, 
org.eclipse.core.expressions.nl1_3.2.0.v200606220026.jar, 
org.eclipse.core.filebuffers.nl1_3.2.0.v200606220026.jar, 
org.eclipse.core.filesystem.nl1_1.0.0.v200606220026.jar, 
org.eclipse.core.jobs.nl1_3.2.0.v200606220026.jar, 
org.eclipse.core.resources.nl1_3.2.0.v200606220026.jar, 
org.eclipse.core.runtime.compatibility.auth.nl1_3.2.0.v200606220026.jar, 
org.eclipse.core.runtime.compatibility.nl1_3.1.100.v200606220026.jar, 
org.eclipse.core.runtime.nl1_3.2.0.v200606220026.jar, 
org.eclipse.core.variables.nl1_3.1.100.v200606220026.jar, 
org.eclipse.debug.core.nl1_3.2.0.v200606220026.jar, 
org.eclipse.debug.ui.nl1_3.2.0.v200606220026.jar, 
org.eclipse.equinox.common.nl1_3.2.0.v200606220026.jar, 
org.eclipse.equinox.preferences.nl1_3.2.0.v200606220026.jar, 
org.eclipse.equinox.registry.nl1_3.2.0.v200606220026.jar, 
org.eclipse.help.appserver.nl1_3.1.100.v200606220026.jar, 
org.eclipse.help.base.nl1_3.2.0.v200606220026.jar, org.eclipse.help.nl1_3.2.0.v200606220026.jar, 
org.eclipse.help.ui.nl1_3.2.0.v200606220026.jar, org.eclipse.jdt.apt.core.nl1_3.2.0.v200606220026.jar, 
org.eclipse.jdt.apt.ui.nl1_3.2.0.v200606220026.jar, 
org.eclipse.jdt.core.manipulation.nl1_1.0.0.v200606220026.jar, 
org.eclipse.jdt.core.nl1_3.2.0.v200606220026.jar, 
org.eclipse.jdt.debug.ui.nl1_3.2.0.v200606220026.jar, 
org.eclipse.jdt.doc.isv.nl1_3.2.0.v200606220026.jar, 
org.eclipse.jdt.doc.user.nl1_3.2.0.v200606220026.jar, 
org.eclipse.jdt.junit4.runtime.nl1_1.0.0.v200606220026.jar, 
org.eclipse.jdt.launching.nl1_3.2.0.v200606220026.jar, org.eclipse.jdt.nl1_3.2.0.v200606220026.jar, 
org.eclipse.jdt.ui.nl1_3.2.0.v200606220026.jar, 
org.eclipse.jface.databinding.nl1_1.0.0.v200606220026.jar, 
org.eclipse.jface.nl1_3.2.0.v200606220026.jar, org.eclipse.jface.text.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ltk.core.refactoring.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ltk.ui.refactoring.nl1_3.2.0.v200606220026.jar, 
org.eclipse.osgi.nl1_3.2.0.v200606220026.jar, org.eclipse.osgi.services.nl1_3.1.100.v200606220026.jar, 
org.eclipse.osgi.util.nl1_3.1.100.v200606220026.jar, org.eclipse.pde.core.nl1_3.2.0.v200606220026.jar, 
org.eclipse.pde.doc.user.nl1_3.2.0.v200606220026.jar, 
org.eclipse.pde.junit.runtime.nl1_3.2.0.v200606220026.jar, 
org.eclipse.pde.nl1_3.2.0.v200606220026.jar, org.eclipse.pde.runtime.nl1_3.2.0.v200606220026.jar, 
org.eclipse.pde.ui.nl1_3.2.0.v200606220026.jar, 
org.eclipse.platform.doc.isv.nl1_3.2.0.v200606220026.jar, 
org.eclipse.platform.doc.user.nl1_3.2.0.v200606220026.jar, 
org.eclipse.rcp.nl1_3.2.0.v200606220026.jar, org.eclipse.search.nl1_3.2.0.v200606220026.jar, 
org.eclipse.swt.nl1_3.2.0.v200606220026.jar, org.eclipse.team.core.nl1_3.2.0.v200606220026.jar, 
org.eclipse.team.cvs.core.nl1_3.2.0.v200606220026.jar, 
org.eclipse.team.cvs.ssh.nl1_3.2.0.v200606220026.jar, 
org.eclipse.team.cvs.ssh2.nl1_3.2.0.v200606220026.jar, 
org.eclipse.team.cvs.ui.nl1_3.2.0.v200606220026.jar, org.eclipse.team.ui.nl1_3.2.0.v200606220026.jar, 
org.eclipse.text.nl1_3.2.0.v200606220026.jar, org.eclipse.ui.browser.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ui.cheatsheets.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ui.console.nl1_3.1.100.v200606220026.jar, 
org.eclipse.ui.editors.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ui.externaltools.nl1_3.1.100.v200606220026.jar, 
org.eclipse.ui.forms.nl1_3.2.0.v200606220026.jar, org.eclipse.ui.ide.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ui.intro.nl1_3.2.0.v200606220026.jar, org.eclipse.ui.navigator.nl1_3.2.0.v200606220026.jar, 



org.eclipse.ui.navigator.resources.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ui.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ui.presentations.r21.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ui.views.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ui.views.properties.tabbed.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ui.workbench.nl1_3.2.0.v200606220026.jar, 
org.eclipse.ui.workbench.texteditor.nl1_3.2.0.v200606220026.jar, 
org.eclipse.update.configurator.nl1_3.2.0.v200606220026.jar, 
org.eclipse.update.core.nl1_3.2.0.v200606220026.jar, 
org.eclipse.update.scheduler.nl1_3.2.0.v200606220026.jar, 
org.eclipse.update.ui.nl1_3.2.0.v200606220026.jar,
com.ibm.icu_3.4.4.1.jar, 
org.eclipse.core.commands_3.2.0.I20060605-1400.jar, 
org.eclipse.core.contenttype_3.2.0.v20060603.jar, 
org.eclipse.core.expressions_3.2.0.v20060605-1400.jar, 
org.eclipse.core.filesystem.linux.x86_1.0.0.v20060603.jar,
org.eclipse.core.filesystem_1.0.0.v20060603.jar, org.eclipse.core.jobs_3.2.0.v20060603.jar,
org.eclipse.core.runtime.compatibility.auth_3.2.0.v20060601.jar,
org.eclipse.core.runtime_3.2.0.v20060603.jar, org.eclipse.equinox.common_3.2.0.v20060603.jar,
org.eclipse.equinox.preferences_3.2.0.v20060601.jar, org.eclipse.equinox.registry_3.2.0.v20060601.jar,
org.eclipse.help_3.2.0.v20060602.jar, org.eclipse.jface.text_3.2.0.v20060605-1400.jar,
org.eclipse.jface_3.2.0.I20060605-1400.jar, org.eclipse.osgi_3.2.0.v20060601.jar,
org.eclipse.swt.gtk.linux.x86_3.2.0.v3232m.jar, org.eclipse.swt_3.2.0.v3232o.jar,
org.eclipse.text_3.2.0.v20060605-1400.jar,
org.eclipse.ui.workbench.texteditor_3.2.0.v20060605-1400.jar, 
org.eclipse.ui.workbench_3.2.0.I20060605-1400.jar, org.eclipse.ui_3.2.0.I20060605-1400.jar, 
runtime_registry_compatibility.jar, eclipse.exe, eclipse.ini, and startup.jar
 (collectively, "Eclipse Software"). 

All Eclipse Software is distributed under the terms and conditions of the Eclipse Foundation Software 
User Agreement (EFSUA) and/or terms and conditions of the Eclipse Public License Version 1.0 (EPL) or 
other license agreements, notices or terms and conditions referenced for the individual pieces of the 
Eclipse Software, including without limitation "Abouts", "Feature Licenses", and "Feature Update 
Licenses" as defined in the EFSUA. 

A copy of the Eclipse Foundation Software User Agreement is found at 
<install_dir>/SI/repository/rcp/rcpdependencies/windows/eclipse/notice.html, 
<install_dir>/SI/repository/rcp/rcpdependencies/windows/eclipse/plugins/notice.html, 
<install_dir>/SI/repository/rcp/rcpdependencies/gtk.linux_x86/eclipse/notice.html, and
<install_dir>/SI/repository/rcp/rcpdependencies/gtk.linux_x86/eclipse/plugins/notice.html.

A copy of the EPL is found at 
<install_dir>/SI/repository/rcp/rcpdependencies/windows/eclipse/plugins/epl-v10.htm, 
<install_dir>/SI/repository/rcp/rcpdependencies/windows/eclipse/epl-v10.htm, 
<install_dir>/SI/repository/rcp/rcpdependencies/gtk.linux.x86/eclipse/plugins/epl-v10.html, and 
<install_dir>/SI/repository/rcp/rcpdependencies/gtk.linux.x86/eclipse/epl-v10.html. 

The reference to the license agreements, notices or terms and conditions governing each individual piece 
of the Eclipse Software is found in the directory files for the individual pieces of the Eclipse Software as 
described in the file identified as installdir/SCI_License.txt.

These licenses only apply to the Eclipse Software and do not apply to the Sterling Commerce Software, 
or any other Third Party Software.

The Language Pack (NL Pack) piece of the Eclipse Software, is distributed in object code form. Source 
code is available at 
http://archive.eclipse.org/eclipse/downloads/drops/L-3.2_Language_Packs-200607121700/index.php. In 
the event the source code is no longer available from the website referenced above, contact Sterling 
Commerce at 978-513-6000 and ask for the Release Manager. A copy of this license is located at 
<install_dir>/SI/repository/rcp/rcpdependencies/windows/eclipse/plugins/epl-v10.htm and 
<install_dir>/SI/repository/rcp/rcpdependencies/gtk.linux.x86/eclipse/plugins/epl-v10.html.  

http://archive.eclipse.org/eclipse/downloads/drops/L-3.2_Language_Packs-200607121700/index.php


The org.eclipse.core.runtime_3.2.0.v20060603.jar piece of the Eclipse Software was modified slightly in 
order to remove classes containing encryption items. The org.eclipse.core.runtime_3.2.0.v20060603.jar 
was modified to remove the Cipher, CipherInputStream and CipherOutputStream classes and rebuild the 
org.eclipse.core.runtime_3.2.0.v20060603.jar.

Ehcache Software

The Sterling Commerce Software is also distributed with or on the same storage media as the ehache 
v.1.5 software (Copyright © 2003-2008 Luck Consulting Pty. Ltd.) ("Ehache Software"). Ehcache 
Software is free software which is distributed under the terms of the Apache License Version 2.0. A copy 
of License Version 2.0 is found in <install>/jar/smcfs/9.0/ehcache-1.5.0.jar (./LICENSE.txt).

The Ehcache Software was not modified. Neither the Sterling Commerce Software, modifications, if any, 
to the Ehcache Software, nor other Third Party Code is a Derivative Work or a Contribution as defined in 
License Version 2.0. License Version 2.0 applies only to the Ehcache Software which is the subject of the 
specific directory file and does not apply to the Sterling Commerce Software or to any other Third Party 
Software. License Version 2.0 includes the following provision:

"Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each 
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS 
OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of 
TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are 
solely responsible for determining the appropriateness of using or redistributing the Work and assume 
any risks associated with Your exercise of permissions under this License." 

ESAPI SOFTWARE

The Sterling Commerce Software is also distributed with or on the same storage media 

as the ESAPI software (Copyright © 2007, the OWASP Foundation) ("ESAPI Software"). ESAPI Software 
Software is free software which is distributed under the terms of the following license:

Copyright © 2007, The OWASP Foundation

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

Neither the name of the OWASP Foundation nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.



EZMorph Software

The Sterling Commerce Software is also distributed with or on the same storage media as the EZMorph 
v. 1.0.4 software (Copyright © 2006-2008 Andres Almiray) ("EZMorph Software"). EZMorph Software is 
free software which is distributed under the terms of the Apache License Version 2.0. A copy of License 
Version 2.0 is found in <install>/jar/ezmorph/1_0_4/ezmorph-1.0.4.jar (./LICENSE.txt).

The EZMorph Software was not modified. Neither the Sterling Commerce Software, modifications, if any, 
to the EZMorph Software, nor other Third Party Code is a Derivative Work or a Contribution as defined in 
License Version 2.0. License Version 2.0 applies only to the EZMorph Software which is the subject of the 
specific directory file and does not apply to the Sterling Commerce Software or to any other Third Party 
Software. License Version 2.0 includes the following provision:

"Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each 
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS 
OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of 
TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are 
solely responsible for determining the appropriateness of using or redistributing the Work and assume 
any risks associated with Your exercise of permissions under this License." 

 

Firebug Lite Software

The Sterling Commerce Software is distributed with or on the same storage media as the Firebug Lite 
Software which is free software distributed under the terms of the following license: 

Copyright © 2008 Azer Koçulu http://azer.kodfabrik.com. All rights reserved.

Redistribution and use of this software in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Azer Koçulu. nor the names of any other contributors may be used to endorse or 
promote products derived from this software without specific prior written permission of Parakey Inc.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

JAVASCRIPT MINIFIER

The Sterling Commerce Software is distributed with or on the same storage media as the JSMin Software 
which is free software distributed under the terms of the following license: 

JSMin.java 2006-02-13; Updated 2007-08-20 with updates from jsmin.c (2007-05-22)

 Copyright © 2006 John Reilly (www.inconspicuous.org)

This work is a translation from C to Java of jsmin.c published by Douglas Crockford. Permission is hereby 
granted to use the Java version under the same conditions as the jsmin.c on which it is based. 

http://azer.kodfabrik.com


   

jsmin.c 2003-04-21

Copyright © 2002 Douglas Crockford (www.crockford.com)

 Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the 
following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software.

The Software shall be used for Good, not Evil.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE 
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

ICE SOFTWARE 

The Sterling Commerce Software is distributed on the same storage media as the ICE Software 
(Copyright © 1997 ICE Engineering, Inc./Timothy Gerard Endres.) ("ICE Software"). The ICE Software is 
independent from and not linked or compiled with the Sterling Commerce Software. The ICE Software is 
a free software product which can be distributed and/or modified under the terms of the GNU General 
Public License as published by the Free Software Foundation; either version 2 of the License or any later 
version. 

A copy of the GNU General Public License is provided at installdir/jar/jniregistry/1_2/ICE_License.txt. 
This license only applies to the ICE Software and does not apply to the Sterling Commerce Software, or 
any other Third Party Software. 

The ICE Software was modified slightly in order to fix a problem discovered by Sterling Commerce 
involving the RegistryKey class in the RegistryKey.java in the JNIRegistry.jar. The class was modified to 
comment out the finalize () method and rebuild of the JNIRegistry.jar file. 

Source code for the bug fix completed by Sterling Commerce on January 8, 2003 is located at: 
installdir/jar/jniregistry/1_2/RegistryKey.java. Source code for all other components of the ICE Software 
is located at http://www.trustice.com/java/jnireg/index.shtml.

The ICE Software is distributed WITHOUT ANY WARRANTY; without even the implied warranty of 
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. 

 

JBOSS SOFTWARE 

The Sterling Commerce Software is distributed on the same storage media as the JBoss Software 
(Copyright © 1999-2002 JBoss.org) ("JBoss Software"). The JBoss Software is independent from and not 
linked or compiled with the Sterling Commerce Software. The JBoss Software is a free software product 
which can be distributed and/or modified under the terms of the GNU Lesser General Public License as 
published by the Free Software Foundation; either version 2.1 of the License or any later version. 

A copy of the GNU Lesser General Public License is provided at: 
<install_dir>\jar\jboss\4_2_0\LICENSE.html

This license only applies to the JBoss Software and does not apply to the Sterling Commerce Software, 
or any other Third Party Software. 

The JBoss Software is not distributed by Sterling Commerce in its entirety. Rather, the distribution is 

http://www.trustice.com/java/jnireg/index.shtml


limited to the following jar files: el-api.jar, jasper-compiler-5.5.15.jar, jasper-el.jar, jasper.jar, 
jboss-common-client.jar, jboss-j2ee.jar, jboss-jmx.jar, jboss-jsr77-client.jar, jbossmq-client.jar, 
jnpserver.jar, jsp-api.jar, servlet-api.jar, tomcat-juli.jar.

The JBoss Software was modified slightly in order to allow the ClientSocketFactory to return a socket 
connected to a particular host in order to control the host interfaces, regardless of whether the 
ClientSocket Factory specified was custom or note. Changes were made to org.jnp.server.Main. Details 
concerning this change can be found at 
http://sourceforge.net/tracker/?func=detail&aid=1008902&group_id=22866&atid=376687. 

Source code for the modifications completed by Sterling Commerce on August 13, 2004 is located at: 
http://sourceforge.net/tracker/?func=detail&aid=1008902&group_id=22866&atid=376687. Source code 
for all other components of the JBoss Software is located at http://www.jboss.org.

JGO SOFTWARE

The Sterling Commerce Software is distributed with, or on the same storage media, as certain 
redistributable portions of the JGo Software provided by Northwoods Software Corporation under a 
commercial license agreement (the "JGo Software"). The JGo Software is provided subject to the 
disclaimers set forth above and the following notice:

U.S. Government Restricted Rights

The JGo Software and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the Government is subject to restrictions as set forth in subparagraph (C)(1)(ii) of the 
Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (C)(1) 
and (2) of the Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as applicable. 
Contractor / manufacturer of the JGo Software is Northwoods Software Corporation, 142 Main St., 
Nashua, NH 03060. 

JSDoc Tookit Software

The Sterling Commerce Software is distributed with or on the same storage media as the JSDoc Toolkit 
software (Copyright © 2008 Michael Mathews) ("JSDoc Toolkit Software"), which is subject to the 
following license:

All code specific to JsDoc Toolkit are free, open source and licensed for use under the X11/MIT License.

JsDoc Toolkit is Copyright © 2008 Michael Mathews <micmath@gmail.com>

This program is free software; you can redistribute it and/or modify it under the terms below.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the 
following conditions: The above copyright notice and this permission notice must be included in all copies 
or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE 
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

  

JSLib Software

The Sterling Commerce Software is distributed with or on the same storage media as the JSLib software 

http://sourceforge.net/tracker/?func=detail&aid=1008902&group_id=22866&atid=376687
http://sourceforge.net/tracker/?func=detail&aid=1008902&group_id=22866&atid=376687
http://www.jboss.org


   

product (Copyright © 2003-2009 Mozdev Group, Inc.) ("JSLib Software"). The JSLib Software is 
distributed under the terms of the MOZILLA PUBLIC LICENSE Version 1.1. A copy of this license is 
located at <install>/repository/eardata/platform_uifwk_ide/war/designer/MPL-1.1.txt. The JSLib 
Software code is distributed in source form and is located at http://jslib.mozdev.org/installation.html.  
Neither the Sterling Commerce Software nor any other Third Party Code is a Modification or Contribution 
subject to the Mozilla Public License. Pursuant to the terms of the Mozilla Public License, the following 
notice applies only to the JSLib Software (and not to the Sterling Commerce Software or any other Third 
Party Software):

"The contents of the file located at http://www.mozdev.org/source/browse/jslib/ are subject to the 
Mozilla Public License Version 1.1 (the "License"); you may not use this file except in compliance with the 
License. You may obtain a copy of the License at http://www.mozilla.org/MPL/

Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY 
KIND, either express or implied. See the License for the specific language governing rights and 
limitations under the License.

The Original Code is Mozdev Group, Inc. code. The Initial Developer of the Original Code is Mozdev 
Group, Inc. Portions created by_Mozdev Group, Inc. are Copyright © 2003 Mozdev Group, Inc. All Rights 
Reserved. Original Author: Pete Collins <pete@mozdev.org>one   Contributor(s):_____none 
listed________.

Alternatively, the contents of this file may be used under the terms of the ____ license (the "[___] 
License"), in which case the provisions of [___] License are applicable instead of those above. If you 
wish to allow use of your version of this file only under the terms of the [___] License and not allow 
others to use your version of this file under the MPL, indicate your decision by deleting the provisions 
above and replace them with the notice and other provisions required by the [___] License. If you do not 
delete the provisions above, a recipient may use your version of this file under either the MPL or the 
[___] License."

The preceding license only applies to the JSLib Software and does not apply to the Sterling Commerce 
Software, or any other Third Party Software. 

 

Json Software

The Sterling Commerce Software is also distributed with or on the same storage media as the Json 2.2.2 
software (Copyright © 2006-2008 Json-lib) ("Json Software"). Json Software is free software which is 
distributed under the terms of the Apache License Version 2.0. A copy of License Version 2.0 is found in 
<install>/jar/jsonlib/2_2_2/json-lib-2.2.2-jdk13.jar.

This product includes software developed by Douglas Crockford (http://www.crockford.com).

The Json Software was not modified. Neither the Sterling Commerce Software, modifications, if any, to 
the Json Software, nor other Third Party Code is a Derivative Work or a Contribution as defined in 
License Version 2.0. License Version 2.0 applies only to the Json Software which is the subject of the 
specific directory file and does not apply to the Sterling Commerce Software or to any other Third Party 
Software. License Version 2.0 includes the following provision:

"Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each 
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS 
OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of 
TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are 
solely responsible for determining the appropriateness of using or redistributing the Work and assume 
any risks associated with Your exercise of permissions under this License." 

Prototype Software

The Sterling Commerce Software is distributed with or on the same storage media as the Prototype 
software (Copyright © 2005-2008 Sam Stephenson) ("Prototype Software"), which is subject to the 
following license:

http://jslib.mozdev.org/installation.html
http://www.mozdev.org/source/browse/jslib/
http://www.mozilla.org/MPL/
http://www.crockford.com


Copyright © 2005-2008 Sam Stephenson

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the 
following conditions:

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE 
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Purple Technology

The Sterling Commerce Software is distributed with or on the same storage media as the Purple 
Technology Software (Copyright © 1995-1999 Purple Technology, Inc.) ("Purple Technology Software"), 
which is subject to the following license:

Copyright © 1995-1999 Purple Technology, Inc. All rights reserved. 

PLAIN LANGUAGE LICENSE: Do whatever you like with this code, free of charge, just give credit where 
credit is due. If you improve it, please send your improvements to alex@purpletech.com. Check 
http://www.purpletech.com/code/ for the latest version and news. 

LEGAL LANGUAGE LICENSE: Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The names of the authors and the names "Purple Technology," "Purple Server" and "Purple Chat" must 
not be used to endorse or promote products derived from this software without prior written permission. 
For written permission, please contact server@purpletech.com. 

THIS SOFTWARE IS PROVIDED BY THE AUTHORS AND PURPLE TECHNOLOGY "AS IS'' AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE AUTHORS OR PURPLE TECHNOLOGY BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The preceding license only applies to the Purple Technology Software and does not apply to the Sterling 
Commerce Software, or any other Third Party Software.

Rico Software

The Sterling Commerce Software is also distributed with or on the same storage media as the Rico.js 
software (Copyright © 2005 Sabre Airline Solutions) ("Rico Software").   Rico Software is free software 
which is distributed under the terms of the Apache License Version 2.0. A copy of License Version 2.0 is 
found in <install>/repository/eardata/platform/war/ajax/scripts/Rico_License.txt.

The Rico Software was not modified. Neither the Sterling Commerce Software, modifications, if any, to 

http://www.purpletech.com/code/


   

the Rico Software, nor other Third Party Code is a Derivative Work or a Contribution as defined in License 
Version 2.0. License Version 2.0 applies only to the Rico Software which is the subject of the specific 
directory file and does not apply to the Sterling Commerce Software or to any other Third Party 
Software. License Version 2.0 includes the following provision:

"Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each 
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS 
OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of 
TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are 
solely responsible for determining the appropriateness of using or redistributing the Work and assume 
any risks associated with Your exercise of permissions under this License."

Rhino Software

The Sterling Commerce Software is distributed with or on the same storage media as the Rhino js.jar 
(Copyright © 1998-2009 Mozilla.org.) ("Rhino Software"). A majority of the source code for the Rhino 
Software is dual licensed under the terms of the MOZILLA PUBLIC LICENSE Version 1.1. or the GPL v. 
2.0. Additionally, some files (at a minimum the contents of 
toolsrc/org/Mozilla/javascript/toolsdebugger/treetable) are available under another license as set forth in 
the directory file for the Rhino Software.

Sterling Commerce's use and distribution of the Rhino Software is under the Mozilla Public License. A 
copy of this license is located at <install>/jar/rhino/1_7R1/License.txt. The Rhino Software code is 
distributed in source form and is located at http://mxr.mozilla.org/mozilla/source/js/rhino/src/. Neither 
the Sterling Commerce Software nor any other Third Party Code is a Modification or Contribution subject 
to the Mozilla Public License. Pursuant to the terms of the Mozilla Public License, the following notice 
applies only to the Rhino Software (and not to the Sterling Commerce Software or any other Third Party 
Software):

"The contents of the file located at <install>/jar/rhino/1_7R1/js.jar are subject to the Mozilla Public 
License Version 1.1 (the "License"); you may not use this file except in compliance with the License. You 
may obtain a copy of the License at http://www.mozilla.org/MPL/

Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY 
KIND, either express or implied. See the License for the specific language governing rights and 
limitations under the License.

The Original Code is Rhino code, released May 6, 1999. The Initial Developer is Netscape 
Communications Corporation. Portions created by the Initial Developer are Copyright © 1997-1999. All 
Rights Reserved. Contributor(s):_____none listed.

The preceding license only applies to the Rico Software and does not apply to the Sterling Commerce 
Software, or any other Third Party Software

SLF4J Software

The Sterling Commerce Software is also distributed with or on the same storage media as the SLF4J 
software (Copyright © 2004-2008) ("SLF4J Software"), which is subject to the following license:

Copyright © 2004-2008 QOS.ch All rights reserved. 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the 
following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 

http://mxr.mozilla.org/mozilla/source/js/rhino/src/
http://www.mozilla.org/MPL/


INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE 
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

 

Sun Microsystems

The Sterling Commerce Software is distributed with or on the same storage media 
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WARRANTY DISCLAIMER

This documentation and the Sterling Commerce Software which it describes are licensed either "AS IS" 
or with a limited warranty, as set forth in the Sterling Commerce license agreement.  Other than any 
limited warranties provided, NO OTHER WARRANTY IS EXPRESSED AND NONE SHALL BE IMPLIED, 
INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR USE OR FOR A PARTICULAR 
PURPOSE. The applicable Sterling Commerce entity reserves the right to revise this publication from time 
to time and to make changes in the content hereof without the obligation to notify any person or entity 
of such revisions or changes.

The Third Party Software is provided "AS IS" WITHOUT ANY WARRANTY AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. FURTHER, IF YOU 
ARE LOCATED OR ACCESSING THIS SOFTWARE IN THE UNITED STATES, ANY EXPRESS OR IMPLIED 
WARRANTY REGARDING TITLE OR NON-INFRINGEMENT ARE DISCLAIMED.

Without limiting the foregoing, the ICE Software and JBoss Software are distributed WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR 
PURPOSE. 
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Preface

This manual explains how to deploy configuration data using the 
Configuration Deployment Tool.

Intended Audience
This manual is intended for use by those who are responsible for 
maintaining the deployments of Selling and Fulfillment Foundation.

Structure
This manual contains the following chapters:

Chapter 1, "Deployment Tools Overview"
This chapter discusses the Configuration Deployment Tool and its 
purpose.

Chapter 2, "Concepts"
This chapter explains some high level concepts related to the 
Configuration Deployment Tool.

Chapter 3, "Understanding the CDT Interface"
This chapter explains features of the Configuration Deployment Tool user 
interface.



xxiv   Configuration Deployment Tool Guide

Chapter 4, "Before Using the Configuration Deployment 
Tool"
This chapter describes the prerequisites necessary to run the 
Configuration Deployment Tool.

Chapter 5, "Running the CDT and Setting Up the Preference 
Settings (GUI-Based)"
This chapter describes the steps necessary to successfully set up and run 
the Configuration Deployment Tool using GUI mode.

Chapter 6, "Running the CDT and Setting Up the Preference 
Settings (Text-Based)"
This chapter describes the steps necessary to successfully set up and run 
the Configuration Deployment Tool using Command Line mode.

Chapter 7, "Transforming Elements Using the CDT"
This chapter describes the concepts and steps behind transforming 
elements.

Chapter 8, "Comparing Source and Target Databases"
This chapter describes how to compare source and target databases, and 
the steps you can take after this has been completed.

Chapter 9, "Deploying Your Configuration Data"
This chapter explains how to deploy configuration data gathered by the 
Configuration Deployment Tool. 

Chapter 10, "Configuration Data Versioning Tool"
This chapter describes the steps necessary to track changes in 
configuration data.

Chapter 11, "Troubleshooting"
This chapter provides some common troubleshooting steps.
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Documentation
For more information about Selling and Fulfillment Foundation 

components, see the following manuals:

Selling and Fulfillment Foundation: Release Notes

Selling and Fulfillment Foundation: Installation Guide

Selling and Fulfillment Foundation: Upgrade Guide

Selling and Fulfillment Foundation: Configuration Deployment Tool 
Guide

Selling and Fulfillment Foundation: Performance Management Guide

Selling and Fulfillment Foundation: High Availability Guide

Selling and Fulfillment Foundation: System Management Guide

Selling and Fulfillment Foundation: Localization Guide

Selling and Fulfillment Foundation: Customization Basics Guide

Selling and Fulfillment Foundation: Customizing APIs Guide

Selling and Fulfillment Foundation: Customizing Console JSP Interface 
for End User Guide

Selling and Fulfillment Foundation: Customizing the RCP Interface 
Guide

Selling and Fulfillment Foundation: Customizing User Interfaces for 
Mobile Devices Guide

Selling and Fulfillment Foundation: Customizing Web UI Framework 
Guide

Selling and Fulfillment Foundation: Customizing Swing Interface 
Guide

Selling and Fulfillment Foundation: Extending the Condition Builder 
Guide

Selling and Fulfillment Foundation: Extending the Database Guide

Selling and Fulfillment Foundation: Extending Transactions Guide

Selling and Fulfillment Foundation: Using Sterling RCP Extensibility 
Tool Guide

Selling and Fulfillment Foundation: Integration Guide
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Selling and Fulfillment Foundation: Product Concepts Guide

Sterling Warehouse ManagementTM System: Concepts Guide

Selling and Fulfillment Foundation: Application Platform Configuration 
Guide

Sterling Distributed Order ManagementTM: Configuration Guide

Sterling Supply Collaboration: Configuration Guide

Sterling Global Inventory VisibilityTM: Configuration Guide

Catalog ManagementTM: Configuration Guide

Sterling Logistics Management: Configuration Guide

Sterling Reverse LogisticsTM: Configuration Guide

Sterling Warehouse Management System: Configuration Guide

Selling and Fulfillment Foundation: Application Platform User Guide

Sterling Distributed Order Management: User Guide

Sterling Supply Collaboration: User Guide

Sterling Global Inventory Visibility: User Guide

Sterling Logistics Management: User Guide

Sterling Reverse Logistics: User Guide

Sterling Warehouse Management System: User Guide

Selling and Fulfillment Foundation: Mobile Application User Guide

Selling and Fulfillment Foundation: Business Intelligence Guide

Selling and Fulfillment Foundation: Javadocs

Sterling Selling and Fulfillment SuiteTM: Glossary

Parcel Carrier: Adapter Guide

Visual ModelerTM: Application Guide

Selling and Fulfillment Foundation: Multitenant Enterprise Guide

Selling and Fulfillment Foundation: Password Policy Management 
Guide

Selling and Fulfillment Foundation: Properties Guide
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Catalog Management: Concepts Guide

Selling and Fulfillment Foundation: Pricing Concepts Guide

Selling and Fulfillment Foundation: Setting Up Quotes

Sterling Sensitive Data Capture Server, Release 1.0: Configuration 
Guide

Sterling Sensitive Data Capture Server, Release 1.0: PA-DSS 
Implementation Guide

Selling and Fulfillment Foundation: Secure Deployment Guide

Business Center: Item Administration Guide

Business Center: Pricing Administration Guide

Business Center: Customization Guide

Business Center: Localization Guide

Conventions
The following conventions may be used in this manual:

Convention Meaning

. . . Ellipsis represents information that has been 
omitted.

< > Angle brackets indicate user-supplied input.

mono-spaced text Mono-spaced text indicates a file name, directory 
path, attribute name, or an inline code example or 
command.

/ or \ Slashes and backslashes are file separators for 
Windows, UNIX, and Linux operating systems. The 
file separator for the Windows operating system is 
"\" and the file separator for UNIX and Linux 
systems is "/". The UNIX convention is used unless 
otherwise mentioned.

<INSTALL_DIR> User-supplied location of the Selling and Fulfillment 
Foundation installation directory. This is only 
applicable for Release 8.0 and later.
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<INSTALL_DIR_OLD> User-supplied location of the Selling and Fulfillment 
Foundation installation directory (for Release 8.0 
and later).

Note: This is applicable only for users upgrading 
from Release 8.0 and later.

<SSDCS_DIR> User-supplied location of the Sterling Sensitive Data 
Capture Server installation directory.

This is applicable for Selling and Fulfillment 
Foundation, Release 9.0 and later.

<YANTRA_HOME> User-supplied location of the Sterling Supply Chain 
Applications installation directory. This is only 
applicable for Releases 7.7, 7.9, and 7.11.

<YANTRA_HOME_OLD> User-supplied location of the Sterling Supply Chain 
Applications installation directory (for Releases 7.7, 
7.9, or 7.11).

Note: This is applicable only for users upgrading 
from Releases 7.7, 7.9, or 7.11.

<YFS_HOME> For Releases 7.3, 7.5, and 7.5 SP1, this is the 
user-supplied location of the Sterling Supply Chain 
Applications installation directory. 

For Releases 7.7, 7.9, and 7.11, this is the 
user-supplied location of the <YANTRA_
HOME>/Runtime directory. 

For Release 8.0 and later, the <YANTRA_
HOME>/Runtime directory is no longer used and has 
been substituted with the location <INSTALL_DIR>.

<YFS_HOME_OLD> This is the <YANTRA_HOME>/Runtime directory for 
Releases 7.7, 7.9, or 7.11.

Note: This is only applicable for users upgrading 
from Releases 7.7, 7.9, or 7.11.

<ANALYTICS_HOME> User-supplied location of the Sterling Analytics 
installation directory.

Note: This convention is used only in the 
Selling and Fulfillment Foundation: Business 
Intelligence Guide.

Convention Meaning
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Note: The Selling and Fulfillment Foundation documentation set uses the 
following conventions in the context of the product name:

Yantra is used for Release 7.7 and earlier.

Sterling Supply Chain Applications is used for Releases 7.9 and 7.11.

Sterling Multi-Channel Fulfillment Solution is used for Releases 8.0 
and 8.2.

Selling and Fulfillment Foundation is used for Releases 8.5 and 9.0. 

<COGNOS_HOME> User-supplied location of the IBM Cognos 8 
Business Intelligence installation directory.

Note: This convention is used only in the 
Selling and Fulfillment Foundation: Business 
Intelligence Guide.

<MQ_JAVA_INSTALL_
PATH>

User-supplied location of the IBM WebSphere® 
MQ Java components installation directory.

Note: This convention is used only in the 
Selling and Fulfillment Foundation: System 
Management and Administration Guide.

<DB> Refers to Oracle®, IBM DB2®, or Microsoft SQL 
Server® depending on the database server.

<DB_TYPE> Depending on the database used, considers the 
value oracle, db2, or sqlserver.

Convention Meaning
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1
Deployment Tools Overview

During incremental configurations of Selling and Fulfillment Foundation, 
changes are typically developed in a test environment and then they are 
rolled out into production. Migrating configuration data can be fairly 
cumbersome and time consuming. Selling and Fulfillment Foundation 
provides a Configuration Deployment Tool that enables you to migrate 
configuration data. This tool ensures data integrity while reducing the 
system downtime to transfer data and minimizing the effort needed to 
ensure accuracy. 

This tool is designed to migrate data that is modified as part of a normal 
day-to-day operation. Note that the Configuration Deployment Tool can 
be used to deploy configuration data that is the result of an upgrade, but 
it should not be used to perform the data upgrade itself. 

Configuration Deployment Tool Features
The Configuration Deployment Tool (CDT) can be accessed from the 
Selling and Fulfillment Foundation Development and Deployment 
WorkBench (also known as the "WorkBench").

CDT provides the following capabilities: 

Transfer complete and partial sets of configuration data or discrete 
logical portions.

Transfer data to and from XML files or databases.

Note: To run the UI for the Selling and Fulfillment 
Foundation Configuration Deployment Tool on a UNIX 
server from a windows client, the UNIX server must have 
XWindows installed on it.
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Transform certain data-like IP addresses and port numbers that are 
different in two environments, depending upon network configuration.

Generate a report of configuration differences by comparing the two 
systems. 
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2
Concepts

This chapter presents and defines terms relevant to the Configuration 
Deployment Tool, and explains how they apply.

2.1 Source and Target Environments
The Selling and Fulfillment Foundation Configuration Deployment Tool 
deploys data from one Selling and Fulfillment Foundation environment to 
another. The deployment could occur from development to test 
environments, from staging to production environments, and so forth. 
The environment that serves as the point of origin for the data is known 
as the "source" environment. The destination environment into which 
data is deployed is defined as the "target" environment. This deployment 
can be in the form of importing and exporting data to and from 
databases or XML files.

Example 2–1 shows the required format of these XML files. 

Note: If you make any changes to the configuration data 
in the source database, the existing transactions in the 
CDT may be affected.

Also, for the YFS_TRAN_LOCN_ATTRS table, only the 
configuration data is copied to the target database. The 
transaction data columns such as Pend_in_volume, 
Pend_in_weight, and Freeze on variance are not copied to 
the target database. The weight and volume are 
recalculated and updated in the target database.
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Source and Target Environments

Example 2–1 Configuration Data XML

<?xml version="1.0" encoding="UTF-8" ?> 
<YFS_ATP_RULESList TableName="YFS_ATP_RULES">

<AtpRules AccumulationDays="730" AdvanceNotificationTime="0" 
AtpRule="DEFAULT" AtpRuleKey="DEFAULT" AtpRuleName="DEFAULT" 
BackwardConsumptionDays="730" ConsiderPoForAlloc="N" Createprogid="" 
Createts="" Createuserid="SYSTEM" ForwardConsumptionDays="730" Lockid="0" 
MaxInventoryHoldDays="730" Modifyprogid="SYSTEM" Modifyts="" 
Modifyuserid="SYSTEM" OrganizationCode="DEFAULT" PastDueDemandDays="730" 
PastDueSupplyDays="730" ProcessingTime="0" /> 

</YFS_ATP_RULESList>

2.1.1 Single-Schema and Multischema Deployment 
Guidelines

The CDT allows you to compare and deploy data in single-schema and 
multischema environments. In both environments, data is organized into 
the following configuration groups: 

Metadata - required for database lookup of core configuration 
information. It is a set of unique tables across versions and performs 
“traffic direction” of connections across multischema, multi-version 
deployments.

Configuration Data - consists of the following groups: 

HUB Data - contains data and rules for the HUB. 

Organization Driven Configuration Data - generally stores system 
or business rules such as sourcing rules, routing guide, and 
shipping preferences, as well as organizations.

Master Data - consists of the following groups: 

 Organization Driven Master Data - contains data that is created 
through batch feeds and is often referenced by other 
organizations and users.

Ship Node Driven Master Data - contains master data relating to 
ship nodes. 

For more information about configuration groups, refer to Section 2.2, 
"Configuration Groups and Driver Entities". 
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2.1.1.1 Single-Schema Deployments
In a single-schema environment, data can be compared and deployed by 
organization. 

To deploy data by organization, follow these steps: 

1. Deploy the Configuration Data Configuration Group for the DEFAULT 
organization and the DEFAULT organization’s participating 
organizations. 

2. Deploy the Configuration Data Configuration Group for organizations 
with configuration data that is referenced by other organizations, 
such as configuration inheritance, carriers, catalog/pricing 
organizations, etc. 

3. Deploy the Master Data Configuration Group.

For more information about deploying data, refer to Section 5.2, 
"Running the Configuration Deployment Tool".

Single-Schema Deployment Examples: 
The following is the participant setup configured for examples 1 and 2: 

DEFAULT

ORG1

ORG2 - inherits configuration from ORG1

ORG3 - defines its own configurations 

CARRIER1 - a carrier that participates with DEFAULT

CARRIER2 - a carrier that participates with ORG2 and ORG3

Example 1:
To deploy ORG2 from source to target with Factory Setup: 

1. Deploy Configuration Data for DEFAULT organization and CARRIER1.

2. Deploy Configuration Data for ORG1, ORG2, and CARRIER2. 

3. Deploy Master Data for ORG2. 

Note: CARRIER2 participates with ORG2. For this reason, 
CARRIER2 must be deployed with ORG2. 
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Source and Target Environments

Example 2: 
To deploy ORG3 from source to target with Factory Setup: 

1. Deploy Configuration Data for DEFAULT and CARRIER1. 

2. Deploy Configuration Data for ORG3 and CARRIER2. 

3. Deploy Master Data for ORG3. 

2.1.1.2 Multischema Deployments
In a multischema environment, data can be compared and deployed by 
organization or by colony. You must deploy the Metadata Configuration 
Group, Organization Data Configuration Group, and Master Data 
Configuration Group separately against the corresponding schemas. For 
more information about multischema configurations in general, see the 
Selling and Fulfillment Foundation: Multitenant Enterprise Guide.

To deploy data by organization or by colony, follow these steps: 

1. Deploy the Metadata Configuration Group. This step is necessary only 
when moving from a test environment to a production environment.   

2. Deploy the Configuration Data Configuration Group for the DEFAULT 
organization and the DEFAULT organization’s participating 
organizations. 

3. Deploy the Configuration Data Configuration Group for organizations 
with configuration data that is referenced by other organizations, 
such as configuration inheritance, carriers, catalog/pricing 
organizations, etc. 

4. Deploy the Configuration Data Group Configuration Group for other 
colonies or organizations belonging to other colonies. 

5. Deploy the Master Data Configuration Group.

6. After deploying all data, run the Colony Map Synchronizer agent, as 
described in the "Time-Triggered Transaction Reference" appendix in 
the Sterling Distributed Order Management: Configuration Guide.   

For more information about deploying data, refer to Section 5.2, 
"Running the Configuration Deployment Tool". 



Source and Target Environments

Concepts   7

Multischema Deployment Examples: 
The following is the participant setup configured for examples 1 and 2:   

DEFAULT COLONY

DEFAULT

ORG1

ORG2 - inherits configuration from ORG1

ORG3 - defines its own configurations

CARRIER1 - participates with DEFAULT

COLONY1

ORG4

ORG5

CARRIER2 - participates with ORG4

Example 1:
To deploy ORG2 from source to target with Factory Setup: 

1. Deploy Configuration Data for DEFAULT organization and CARRIER1. 

2. Deploy Configuration Data for ORG1 and ORG2. 

3. Deploy Master Data for ORG2. 

4. Run Colony May Synchronizer. 

Example 2: 
To deploy COLONY1 from source to target with Factory Setup: 

1. Deploy Configuration Data for DEFAULT organization and CARRIER1. 

2. Deploy Configuration Data for COLONY1, which includes Configuration 
Data for ORG4, ORG5, and CARRIER2. 

3. Deploy Master Data for COLONY1. 

4. Run Colony Map Synchronizer.   

Note: CARRIER2 participates with ORG4. For this reason, 
CARRIER2 must be deployed with ORG4. 
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Configuration Groups and Driver Entities

2.2 Configuration Groups and Driver Entities
The entire set of the Selling and Fulfillment Foundation configuration data 
is broken down into logical subsets called "configuration groups" and 
"driver entities". Configuration groups and driver entities are predefined 
and cannot be changed.

During the deployment process, if you need to perform more granular 
inserts, updates, and deletes so that your target database matches your 
source, you choose these configuration groups or driver entities.

Driver Entities
Most of the Selling and Fulfillment Foundation configuration data can be 
deployed starting with a logical entity, for example, an organization or a 
pipeline. These logical entities are called "driver entities". Driver entities 
represent the most granular level of information that can be deployed 
from the source to the target without loss of data integrity.

Only driver entities allow deployment at a record level. For other tables 
either of the following conditions apply: 

The table is completely deployed if it is not dependent on any driver 
entity.

Only records corresponding to the driver entity are deployed.

Information about driver entities can be stored in multiple tables and 
when deploying an entity, data in all related tables is deployed together 
in one transaction boundary to preserve data consistency. 

Configuration Groups
Logically related tables or driver entities are also grouped together into 
"configuration groups" that typically represent larger, significant logical 
data models within Selling and Fulfillment Foundation. Examples include 
the Business Process Model or the Participant Model. These groups are 
provided for convenience and for ease of navigation on the user 
interface.
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2.3 Externally Maintained Configuration Data
In your implementation of Selling and Fulfillment Foundation, you may be 
required to import certain data into your target that is not part of your 
source Selling and Fulfillment Foundation database. For these tables, you 
should not use CDT to deploy data as it does not have access to the 
correct data.

Best Practices
If you must use the Configuration Deployment Tool to deploy externally 
maintained data, the recommended way to handle this is to import this 
data into the source and then use CDT to deploy it into the target. This 
guarantees data integrity. 
IIf you cannot import this data into your source database, Selling and 
Fulfillment Foundation supplies features that enable you to work with 
external data by ensuring that the target database either ignores these 
tables or appends them. Use the Ignore and Append-only features only if 
you have tried all other available options and only after subjecting your 
environment to rigorous testing. 
 the 

Ignore
In cases where data in tables is maintained externally, you can omit 
these tables from the deployment operation by specifying a preference 
for them to be ignored. 

Ignoring a table or a driver entity also automatically ignores all its 
dependent tables. However, there are some tables that store data for 
multiple driver entities and are present in multiple groups. An example of 
this is the YFS_GRAPH_UI table that contains data for pipelines, services 
and statuses. Ignoring one of these tables causes CDT to incorrectly 
mark the corresponding records for deletion.

Caution: When using the Ignore or Append-only features, 
the CDT cannot guarantee the integrity of any external 
data. In order to ensure data integrity, CDT must have 
complete access to the configuration data. 



10   Configuration Deployment Tool Guide

Deploying Custom Tables

Append-Only Mode
In cases where some tables are partially maintained externally, you can 
specify preferences to ensure that these tables are deployed in an 
"append-only" mode.

For append-only tables, the dependent tables are not ignored. Marking a 
table as append-only implies that only a few rows in the target database 
are maintained on the source system—other rows are externally 
imported. In such cases, it is extremely important that there is no 
overlap between the data present in the source and the external system. 
For example, if you maintain your shipping nodes in the source database 
and import store information directly into the target, you must not have 
any stores in the source database. This leads to unpredictable results.

2.4 Deploying Custom Tables
The CDT automatically deploys the configuration tables and extensions 
defined within the Selling and Fulfillment Foundation database 
framework. If you have custom (non-Selling and Fulfillment Foundation) 
configuration tables defined in your installation, CDT needs to be 
specially configured to deploy these tables. To enable CDT to deploy 
these tables, the tables need to be registered with CDT by creating a 
special custom deployment XML file, called cdt_custom.xml. A sample of 
this file can be found in your <INSTALL_DIR>/resources/ydkresources 
directory. This file defines a group named "Custom Tables" and should 
include a list of your custom tables. CDT automatically compares, 
displays, and deploys changes to custom records for all tables that have 
one or more primary key columns.

This tool does not support custom tables as drivers or the representation 
of custom tables in a dependency tree structure. As a result, all custom 
tables can only be deployed together as part of the "Custom Tables" 
group. It also does not support custom tables without a primary key.

The cdt_custom.xml file contains the following:

<Group Name="Custom Tables">
<Table Name="CUSTOM_CONFIG_TABLE_1"/>
<Table Name="CUSTOM_CONFIG_TABLE_2"/>

</Group>
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2.5 Foreign Key Checks
The CDT enforces data consistency by deploying all related tables that 
define an entity together in one operation. In addition, to ensure data 
integrity, the CDT also checks the required foreign key constraints for 
each table - which could potentially be defined for a table in a completely 
different group. Therefore, when deploying a small subset of data, it is 
possible that you may see error messages indicating foreign key 
constraint violations if the corresponding data in the independent table is 
not being deployed in the same operation. In this case, you should try 
deploying a bigger set of data. Note that foreign key constraints are not 
defined or checked for custom tables. 

To provide the best performance, foreign key constraints are not checked 
when deploying the complete Selling and Fulfillment Foundation 
configuration.

2.6 Data Transformations
Frequently, development and production environments have different 
values for network settings such as server names and IP addresses. 
Some configuration data tables in the Selling and Fulfillment Foundation 
store host names, IP addresses, and URLs. While these are valid for your 
source environment, when deploying this data into the target 
environment, the configuration must be updated with the corresponding 
values applicable to the target environment. The CDT enables you to 
automatically transform these data elements into target-appropriate 
values by letting you specify transformations to be carried out on the 
source data before it is deployed into the target.

2.7 Resource Files
The CDT-specific resource files are located in the 
<INSTALL_DIR>/resources/ydkresources directory. These resource files 
allow you to modify the CDT preference settings, database-specific 
settings, and so forth.

cdt_custom.xml.sample
The cdt_custom.xml.sample is a sample of the special custom 
deployment XML file that can be used to deploy the custom tables 
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defined in your installation. For more information about deploying custom 
tables, see Section 2.4, "Deploying Custom Tables".

cdt_dbdefaults.properties
This cdt_dbdefaults.properties file is used to provide extra database pool 
options for given database types. It contains default values for various 
databases that are used while configuring the CDT. The CDT uses this file 
to handle the database connections.

ydkprefs.xml
The ydkprefs.xml file contains the preference settings defined for the 
CDT and is created when you run the GUI-based CDT. It contains the 
configure preferences (such as a Reports Directory) and parameters that 
determine the behavior of the comparison operation of the CDT.

ydkprefs.xml.sample
The ydkprefs.xml.sample file is automatically included in the Selling 
and Fulfillment Foundation installation. You can edit it to specify 
configuration preferences (such as a Reports Directory) and parameters 
that determine the comparison operation behavior of the CDT. When 
finished modifying this sample file, rename it to ydkprefs.xml.
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3
Understanding the CDT Interface

When the Configuration Deployment Tool starts, it prompts you to specify 
the details about your source and target databases to use during the 
session. After you have successfully connected to your source and target 
databases, the Deployment Explorer window appears. 

3.1 The Deployment Explorer
The Deployment Explorer window displays the list of configuration 
groups, driver entities, and tables that can be deployed. The names you 
define for the source and target databases are displayed in the heading 
panel. 

Each time you log into the Configuration Deployment Tool there is one 
instance of this window. 
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Figure 3–1 Deployment Explorer 

You can choose the configuration group or the driver entity that you want 
to compare between the source and target databases.

During the compare operation, the progress and the results of the 
comparison operation are displayed in the Comparison Results window 
and in the Status panel.

Configuration Group
Driver Entity

Table
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3.2 Comparison Results Window
The Comparison Results window displays the outcome of the comparison 
between the source and target databases. 

The Comparison Results window displays information pertaining to the 
current session. Only one Comparison Results window can be displayed 
during each session. After viewing the results of one comparison, you 
must close the window before you can compare a different set of tables.

Figure 3–2 Comparison Results Window
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After generating comparison results, you can carry out any one of the 
following tasks: 

Generate a report of the differences

View the details of each difference

Deploy configuration data from the source database into the target 
database

3.3 The Deployment Tool Status Panel 
The Status panel displays information about operations while they are 
carried out.

Figure 3–3 Configuration Deployment Tool Status Panel
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4
Before Using the Configuration Deployment

Tool

Before you begin using the Configuration Deployment Tool, ensure that 
you have addressed the policies and system requirements described in 
this section.

4.1 System Requirements
The RAM requirements of the Configuration Deployment Tool depend on 
the size of your database and the distribution of your configuration data.

4.1.1 Time Estimates
The time required for the Configuration Deployment Tool to perform 
comparison and deployment tasks varies according to your system 
resources and the size and distribution of your configuration data. For 
example, processing time may increase when there are many records in 
a table that are referenced by foreign key constraints from other tables, 
or when there are many records in a table that serves as a driver entity. 

During tests of the Configuration Deployment Tool, Selling and Fulfillment 
Foundation measures the amount of time it takes to perform tasks on a 
Pentium class machine with 512 MB of RAM and running at 550 MHz. The 
Configuration Deployment Tool performed as described in Table 4–1, 
"Time Estimates using the Configuration Deployment Tool". 

Note: It is recommended that you migrate no more than 
200,000 records per deployment. 
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4.1.2 Installation
The Configuration Deployment Tool is installed automatically during the 
installation of Selling and Fulfillment Foundation.

4.1.3 Environment State
The Configuration Deployment Tool assumes that your source and target 
environments match exactly in the following respects: 

Release of Selling and Fulfillment Foundation (including hot fixes)

Release of JDBC drivers

Release of database software

Database structure (schema objects such as tables, indexes, and 
sequences)

Table 4–1 Time Estimates using the Configuration Deployment Tool

Task Description of Databases Time

Comparison Source database - 110,000 records

Target database - 110,000 records

7 minutes

Comparison Source database - 110,000 records

Target database - empty

4 minutes

Deployment 110,000 differences 11 minutes

Note: Tests of the Configuration Deployment Tool on a 
64-bit machine with 3 GB of RAM and running at 2 GHz 
demonstrate that the CDT can compare and deploy a 
maximum of 750,000 records per enrollment.
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As this Configuration Deployment Tool is used by technical professionals 
for tasks they perform on an occasional basis, it is not localizable or 
customizable. However, you can specify configuration preferences as 
described in this chapter. 

4.2 Security Strategy
The Configuration Deployment Tool makes use of the user authentication 
and authorization supplied by your database provider. Access control and 
authorization are not specified through the Configuration Deployment 
Tool.

Ensure that the person using the Configuration Deployment Tool has 
sufficient authentication privileges (select, insert, update, and delete) for 
both databases; full DBA privileges are not required.

4.3 CDT Change Management Strategy
The Configuration Deployment Tool does not enforce checks to restrict 
configuration data modification on the source or the target schemas 
using other means. You must develop and enforce your own 
methodology. 

For example, if you use the Configuration Deployment Tool to migrate 
data from staging to production, it is not expected that the configuration 
in production is modified by means other than this tool. In such a case 
those changes are overwritten the next time CDT is run. Also, this could 
potentially lead to data integrity issues if the changes are performed in 
either the source or target while CDT is being run. 

The Configuration Deployment Tool is not supported for implementations 
where configuration data is directly modified in production using the 
Applications Manager or any other means. For exceptional cases like 
urgent or critical fixes to configuration data in production, you must 
update the staging database with the same changes.

Note: Before using the Configuration Deployment Tool, 
make sure that you have run the Factory Setup on both 
source and target environments.
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4.4 Rollback Strategy
To prevent application failure and downtime, implement a rigorous 
rollback methodology that involves creating a backup snapshot of your 
configuration data in production before you use the Configuration 
Deployment Tool to deploy changes. This backup is accomplished by 
using the database-specific export and import utilities. Selling and 
Fulfillment Foundation provides some samples for Oracle, DB2, and 
Microsoft SQL Server databases that you can customize for your own 
use. For more information on data rollback, see Section 11.4, "Data 
Rollback Scripts"

4.5 Upgrades and Maintenance
Using the Configuration Deployment Tool should not impact the 
methodology for applying upgrades or hot fixes in a multi-step staging 
environment. 

The upgrade methodology being followed should not change for 
environments already set up for staging before production. However, the 
Configuration Deployment Tool by itself does not provide support for all 
of the processes and methodologies required for supporting a multi-step 
application staging and deployment environment because it is only 
capable of deploying configuration data. 

The process of applying product upgrades and patches is especially 
complex in an environment where the staging area must be kept 
synchronized with production. One way to keep these environments 
harmonious is to apply software patches to both systems simultaneously 
and reverse deploy the data upgrades. This is because application data 
upgrades may behave differently and produce different results based on 
the transactional data they encounter. If this application data upgrade is 
run independently on production and staging, the results may be 
significantly different as a result of the differences in transactional data 
that the upgrade program encountered. In such a case, the production 
snapshot should be treated as the baseline and reverse deployed into 
staging. This can be accomplished by configuring your production 
database as the source and your staging database as the target.
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4.5.1 Example Upgrade Scenario
In an example upgrade scenario, Selling and Fulfillment Foundation 
introduces a feature that recognizes the various attributes for order 
types. For example, an Order_type "URGENT" implies that the order 
should be displayed in the user interface with a specific icon that enables 
you to distinguish it from other orders. However, in previous releases, 
you may have been using the Order_type field to classify orders into 
other types because this field was designed for order classification. 

When Selling and Fulfillment Foundation provides an upgrade toolkit, one 
component of the toolkit handles upgrades to the Order_type field. 

The upgrade logic may flow as follows: 

1. Read all the distinct values of the Order_type field from the 
YFS_ORDER table.

2. For each different Order_type in the your system, create entries in 
the Order_Type_Master configuration table and assign a default icon 
to it.

If this data upgrade is run on the staging system, it will not find any 
orders, so the Order_Type_Master table will only contain "URGENT" which 
is provided by default. 

However, when the same data upgrade is run in production, the 
Order_Type_Master table will contain multiple entries, one for each type 
of order that is in the transaction database. 

Then, when the Configuration Deployment Tool is run again, it marks all 
of these new records for deletion because the source is assumed to be 
the most up-to-date configuration.

As a result, you should design upgrade kit or hot-fixes for transaction 
dependent configuration data as follows:

1. The upgrade kit (or hot-fix) should have one script to prepare input 
for upgrade of transaction-dependent configuration data (for 
example, prepared list of distinct order types). Then you can run this 
script on the production database. You can also run this script in the 
test database and can take the union of the two.

2. The next step in the upgrade should use this as input and upgrade 
the configuration data accordingly. For example, inserting into 
ORDER_TYPE_MASTER table.
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If you have identified any changes in the configuration data, please 
contact the Selling and Fulfillment Foundation Technical Support team at: 
http://www.sterlingcommerce.com/scm_support/ for instructions on how 
to proceed.

http://www.sterlingcommerce.com/scm_support/
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5
Running the CDT and Setting Up the

Preference Settings (GUI-Based)

This chapter explains how to run the Configuration Deployment Tool from 
a GUI and how to configure preference settings.

5.1 Command-Line Arguments
When you run the Configuration Deployment Tool, you can optionally use 
any of the command parameters shown in Table 5–1:

 

Table 5–1 Java ydk Command-Line Arguments

Arguments Description

IgnoreMissingTa
bles

Specifies that when you compare source and target databases, 
you want to ignore tables that might be missing in the target 
schema. When comparing databases in a multischema 
deployment, ensure that you specify the 
IgnoreMissingTables parameter. 

For example, when comparing a Test Configuration schema 
with a Production Configuration schema, some Master tables, 
such as YFS_CUSTOMER and YFS_USER, do not exist in either 
the source or target schema. In this case, the CDT throws 
"table not found" errors. However, you can enable the CDT to 
ignore missing tables by passing -IgnoreMissingTables as 
Y. 

Example:

Windows: ydk.cmd -IgnoreMissingTables Y

Linux/UNIX: ydk.sh -IgnoreMissingTables Y    
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5.2 Running the Configuration Deployment Tool
This section describes how to start and stop the Configuration 
Deployment Tool.

To start the Configuration Deployment Tool:

1. Start the Selling and Fulfillment Foundation Development and 
Deployment WorkBench. On Microsoft Windows, run the ydk.cmd 
script for windows (ydk.sh for UNIX/Linux) from the 
<INSTALL_DIR>\bin directory.

2. From the Selling and Fulfillment Foundation Development and 
Deployment WorkBench menu, choose Tools > Deployment > 
Configuration Data Deployment. This opens the Configuration 
Deployment Tool Logon dialog box.

ConfigDbDir Indicates the directory that contains config-db.xml and 
other related files. By default, the ConfigDbDir argument looks 
for the config-db.xml file in the 
<INSTALL_DIR>/database/cdt directory.

Example:

Windows: ydk.cmd -ConfigDbDir <directory_path>

Linux/UNIX: ydk.sh -ConfigDbDir <directory_path>

Note: To run the UI for the Configuration Deployment 
Tool on a UNIX server from a windows client, the UNIX 
server must have XWindows installed on it.

Note: The Windows console displays WorkBench startup 
information. Do not close the console while the WorkBench 
is running. Closing the console closes the tool, and your 
work is lost.

Table 5–1 Java ydk Command-Line Arguments

Arguments Description
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Figure 5–1 Configuration Deployment Tool Logon Dialog Box

3. Choose the Source button and enter the values appropriate for the 
source database. Then choose the Target button and enter the values 
appropriate for the target database.

In a multischema environment, you must migrate each configuration 
group, one at a time. if you are migrating HUB Data and Organization 
Driven Configuration Data, these two configuration groups must be 
your sources. These groups are displayed in the Deployment Explorer 
and are provided as part of Selling and Fulfillment Foundation. 

Figure 5–2 Deployment Explorer Source-Target File System

Your configuration data is in the HUB Data and Organization Driven 
Configuration Data groups, so the target for each of these should be 
the Configuration Schema. If you are migrating Organization Driven 
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Master Data, the target should be the Master Data Schema. To 
migrate Metadata, the target should be the Metadata schema. 

When you are finished, close the dialog box. The values you specified 
are saved automatically and persist from one session to the next.

In the Source database and Target database windows, specify the 
applicable values as described in Table 5–2.

Note: Most preference settings are tied to a specific 
source and target database combination. If you change the 
name of either the source or target database, any existing 
settings are not used. To return to your old settings, revert 
to the old source and target database name. 

Table 5–2 Configuration Deployment Tool Logon Dialog Box

Field Detail

Name Specify a logical database identifier. For the source, specify 
the database you want to copy data from. For the target, 
specify the database to write the data to. 

className Specify the class name of your database driver as follows: 

If using Oracle, set to:  oracle.jdbc.OracleDriver

If using Microsoft SQL Server 2005/2008, set to: 
com.microsoft.sqlserver.jdbc.SQLServerDriver

If using DB2, set to: com.ibm.db2.jcc.DB2Driver

jdbcURL Specify the URL to connect to the database:

If using Oracle, set to: 
jdbc:oracle:thin:@<DatabaseServerHostname/IP
address>:<TNSListenerPortNumber>:<DatabaseSI
D>.

If using Microsoft SQL Server 2005/2008, set to: 
jdbc:sqlserver://<Database Server 
Hostname>:<Port 
Number>;DatabaseName=<Database name>.

If using DB2, set to: jdbc:db2://<Database Server 
Hostname>:<Port Number>/<Database name>.
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4. In the Logon dialog box, enter the passwords associated with the 
user names. 

The Deployment Explorer window displays. 

To stop the Configuration Deployment Tool:

From the Selling and Fulfillment Foundation Development and 
Deployment WorkBench menu, choose File > Exit. 

This closes the Configuration Deployment Tool and the Windows console. 

dbType Specify the type of database you are running. Enter it in all 
lower case, as shown: 

For Oracle, specify oracle

For Microsoft SQL Server, specify sqlserver

For DB2, specify db2

For an XML datasource, specify xml

folder If using an XML datasource, specify the complete path of the 
folder location for the XML files.

httpurl Only applicable for the target database. Specify a URL for the 
application server whose data cache is to be refreshed after 
data is deployed into the target database. Use the syntax: 
http://<hostname/ip-address>:<port-number>/Appl
ication/interop/InteropHttpServlet, where 
hostname, IP-address and port-number are the parameters 
used to connect to the application server. 

httpuser Specify the surname associated with the application server 
whose data cache is to be refreshed after data is deployed into 
the target database.

schema Specify the schema owner as follows: 

If you are using Oracle or DB2 database, and the user you 
specify is different from the Selling and Fulfillment 
Foundation schema owner, specify the owner of the Selling 
and Fulfillment Foundation schema.

If you are using Microsoft SQL Server, leave this blank.

user Specify the user name associated with the database.

Table 5–2 Configuration Deployment Tool Logon Dialog Box

Field Detail
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5.3 Setting Preference Settings
You can configure preferences (such as a reports directory) and 
parameters that determine the behavior of the comparison operation. 
When you modify these properties, the changes persist, so you do not 
need to reset them each time you use CDT. These changes are saved in 
the <INSTALL_DIR>/resources/ydkresources/ydkprefs.xml file.

To specify Configuration Deployment Tool settings: 

1. Start the Configuration Deployment Tool. For more information about 
starting the Configuration Deployment Tool, see the Section 5.2, 
"Running the Configuration Deployment Tool".

2. From the Deployment Explorer action bar, choose the  Preferences 
icon.

3. In the Preferences window, fill in values using the descriptions 
provided in Table 5–3.

   

Note: The ydkprefs.xml is created the first time you 
start the CDT from the GUI. Alternatively, you can 
manually create the ydkprefs.xml file without starting the 
CDT from the GUI, which allows you to invoke the 
ydkprefs.xml file from the command line. For information 
about manually creating and editing the ydkprefs.xml file, 
see Section 6.3, "Editing ydkprefs.xml". 

Table 5–3 Configuration Deployment Tool Preference Settings

Control Description

Settings Tab

Reports Directory 
(for CDT) 

If you are running CDT, specify the absolute path where 
you want reports to be generated. 

Reports Directory 
(for CDV Tool)

If you are running CDV Tool, specify the absolute path 
where you want to export the comparison results 
report.

Custom Deployment 
Class

Specify the name of the class that should be invoked for 
deploying custom tables not handled by CDT.
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Max Changes to 
Display

Specify the maximum number of differences to be 
displayed. The default display number is 100. 

Audit Version Deployment

Validate Old Values If you select this check box, the system detects conflict 
based on the expected old value of an attribute of a 
record of the obtained changes from the source database 
against the current value of the corresponding record in 
the target database.

Validate Lockid If you select this check box, the system detects conflict 
based on the expected Lockid of a record of the obtained 
changes from the source database against the current 
Lockid of the corresponding record in the target 
database.

Validate Record 
Exists Before Delete

If you select this check box, the system validates the 
record exists in the target database before it 
attempts to delete it. If the record is not there, the 
operation will be marked as a conflict.

Transformations Tab

Table Element Tables that can be added or deleted. 

Table Name Attribute Specify the name of the table on which you want to carry 
out the transformation. The syntax and case must match 
the name of the table used in the Selling and Fulfillment 
Foundation ERDs. Custom tables cannot be transformed. 
Choose the Details icon to specify a value. 

Column Element Columns that can be added or deleted. 

Column Name 
Attribute

Specify the name of the column containing the data to 
be transformed. The syntax and case must match the 
name of the column used in the Selling and Fulfillment 
Foundation ERDs. Extended columns can be transformed. 
Choose the Details icon to specify a value. 

Transform Element Define the transformation for this column. For each 
column, you can define one or more transformations. 
These transformations are applied to data in this column 
in sequential order. You can specify multiple 
transformations for each column, using the delete action 
to remove the parent element.

Table 5–3 Configuration Deployment Tool Preference Settings

Control Description
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Match Attribute Specify the pattern to search for in the source data. All 
matching occurrences of this pattern are replaced with 
the value specified in the Replace attribute. Choose the 
Details icon to specify a value. 

Replace Attribute Specify the value to replace the pattern with. Choose the 
Details icon to specify a value. 

XPath Attribute Conditional. If the column to be transformed contains 
non-XML data, you do not need to specify this XPath 
attribute. However, some configuration information in 
Selling and Fulfillment Foundation is stored as XML in the 
database. 

If the column to be transformed contains XML data, use 
this attribute to specify the location of the exact attribute 
to be transformed. 

Use the syntax:  
xml:/Configuration/Connection/Host/@IPAddre
ss. Choose the Details icon to specify a value. 

Append-Only Tables Tab

Append-only Tables Specify configuration table, if any, in which some rows 
maintain data that is external to Selling and Fulfillment 
Foundation. This prevents the data from being deleted 
during deployment. Specify that table and all of its 
dependent tables. 

Note: Rows that are maintained externally should never 
be present in your source database, since this can lead 
to unpredictable results. 

Ignore Tables Tab

Ignore Tables Specify any external configuration tables that you do not 
want the tool to deploy from the source to the target. 
Ignoring a table automatically ignores all dependent 
tables as well. 

Table 5–3 Configuration Deployment Tool Preference Settings

Control Description
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6
Running the CDT and Setting Up the

Preference Settings (Text-Based)

This chapter explains how to run the Configuration Deployment Tool from 
a command line and how to configure preference settings.

6.1 Command-Line Arguments
When you run the Configuration Deployment Tool, you can optionally use 
any of the command parameters shown in Table 6–1:

 

Table 6–1 Java cdtshell Script Command-Line Arguments

Arguments Description

ColonyId Specifies the Colony ID that you want to compare or deploy.

Example:

Windows: cdtshell.cmd -ColonyId E1

Linux/UNIX: cdtshell.sh -ColonyId E1  

You can pass only one colony at a time.
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IgnoreMissingTa
bles

Specifies that when you compare source and target databases, 
you want to ignore tables that might be missing in the target 
schema.When comparing databases in a multischema 
deployment, ensure that you specify the 
IgnoreMissingTables argument.    

For example, when comparing a Test Configuration schema 
with a Production Configuration schema, some Master tables, 
such as YFS_CUSTOMER and YFS_USER, do not exist in either 
the source or target schema. In this case, the CDT throws 
"table not found" errors. However, you can enable the CDT to 
ignore missing tables by passing -IgnoreMissingTables as 
Y. 

Example:

Windows: cdtshell.cmd -IgnoreMissingTables Y

Linux/UNIX: cdtshell.sh -IgnoreMissingTables Y 

LabelId Specifies the Label Id value that is used to create labels such 
as BEGIN_<LabelId> and END_<LabelId>, before and after 
the deployment, respectively. If this argument is not passed,  
labels are not created.

Example:

Windows: cdtshell.cmd -LabelId OrgA1

Linux/UNIX: cdtshell.sh -LabelId OrgA1

Table 6–1 Java cdtshell Script Command-Line Arguments

Arguments Description



Running the Configuration Deployment Tool (Text-Based)

Running the CDT and Setting Up the Preference Settings (Text-Based)   33

6.2 Running the Configuration Deployment Tool 
(Text-Based)

This section explains how to run the Configuration Deployment Tool from 
a command line, using a text-based (non-GUI) interface.

To run the Configuration Deployment Tool from command line:

1. Edit the <INSTALL_DIR>/bin/cdtshell.cmd.in script for windows 
(cdtshell.sh.in for UNIX/Linux) and set the following properties:

CompareOrgani
zationCode

Specifies the organizations you want to compare based on the 
organization codes passed, as defined in the config-db.xml. 
If you do not pass the CompareOrganizationCode 
argument, the corresponding filter is not used. 

Use a comma-delineated format to specify organizations to 
compare, such as Org-1,Org-2. If you use the 
CompareOrganizationCode argument and specify no 
organizations, the CDT compares all organizations. It is 
recommended that all participating organizations are 
compared together. For example, if two organizations, Org-01 
and Org-02, participate with two ship nodes, Node-01 and 
Node-02, you should specify Org-1,Org-2,Node-01,Node-02.

Example:

Windows: ydk.cmd -CompareOrganizationCode 
Org-1,Org-2,Node-01,Node-02

Linux/UNIX: ydk.sh -CompareOrganizationCode 
Org-01,Org-02,Node-01,Node-02

Note: For information about running the CDT in 
multischema deployments, see Section 5.2, "Running the 
Configuration Deployment Tool".

Table 6–1 Java cdtshell Script Command-Line Arguments

Arguments Description
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2. Run the <INSTALL_DIR>/bin/setupfiles.cmd script for windows 
(setupfiles.sh for UNIX/Linux).

3. Configure CDT preferences and parameters for the comparison 
operation. The ydkprefs.xml file determines CDT preferences and is 
automatically created when you run the CDT from the GUI; however, 
you can also manually create and edit the ydkprefs.xml file without 
using the CDT GUI. For information about manually creating and 
editing the ydkprefs.xml file, see Section 6.3, "Editing 
ydkprefs.xml".

4. Run the cdtshell.cmd script for windows (cdtshell.sh for 
UNIX/Linux) from the <INSTALL_DIR>\bin directory.

Property Description

SOURCE_DB The logical identifier for the source database. This 
value corresponds to the Name setting in the 
<SourceDatabases> element in the 
ydkprefs.xml file. 

TARGET_DB The logical identifier for the target database. This 
value corresponds to the Name setting in the 
<TargetDatabases> element in the 
ydkprefs.xml file.  

SOURCE_PASSWORD Specify the password required for the source 
database.

Note: This parameter is not required to be set if 
the source is an XML folder.

TARGET_PASSWORD Specify the password required for the target 
database.

Note: This parameter is not required to be set if 
the source is an XML folder.

TARGET_HTTP_PASSWOR
D

Specify the password of the http user required to 
refresh the cache on the server.

Note: This parameter is not required if there is 
no cache to refresh on the server.
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6.3 Editing ydkprefs.xml
You can manually configure preferences and parameter settings that 
determine the behavior of the comparison operation by editing the 
ydkprefs.xml.sample file and saving the file as ydkprefs.xml. 

To configure Configuration Deployment Tool preference settings: 

1. Rename the 
<INSTALL_DIR>/resources/ydkresources/ydkprefs.xml.sample 
file to ydkprefs.xml.

2. In ydkprefs.xml, specify parameters for CDT preference elements. 
Table 6–2 describes the elements in ydkprefs.xml.  

Table 6–2 Configuration Deployment Tool Preference Settings

Element Description

<Settings> Element

CustomEntityClass Specify the name of the class that should be invoked for 
deploying custom tables not handled by CDT.

Note: If you don’t want to use this field, set the value of 
this field to null. For example, CustomEntityClass="".

MaxChangesToDispla
y

Specify the maximum number of differences to be 
displayed. The default display number is 100.

Note: If you don’t want to use this field, set the value of 
this field to null. For example, MaxChangesToDisplay="".

ReportsDir Specify the absolute path where you want reports to be 
generated.

Note: If you don’t want to use this field, set the value of 
this field to null. For example, ReportsDir="".

ValidateLockid Specify Y, if you want the system to detect conflict based 
on the expected Lockid of a record of the obtained 
changes from the source database against the current 
Lockid of the corresponding record in the target 
database.

By default, it is set to N.
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ValidateOldValues Specify Y, if you want the system to detect conflict based 
on the expected old value of an attribute of a record of 
the obtained changes from the source database against 
the current value of the corresponding record in the 
target database.

By default, it is set to Y.

ValidateRecordExists
BeforeDelete

Specify Y, if want the system to validate the record 
exists in the target database before it attempts to 
delete it. If the record is not there, the operation 
will be marked as a conflict.

By default, it is set to Y.

<SourceDatabases> Element

Name Specify a logical database identifier. For the source, 
specify the database you want to copy data from. For the 
target, specify the database to write the data to. 

className Specify the class name of your database driver as 
follows: 

If using Oracle, set to:  
oracle.jdbc.OracleDriver

If using Microsoft SQL Server 2005/2008, set to: 
com.microsoft.sqlserver.jdbc.SQLServerDr
iver

If using DB2, set to: 
com.ibm.db2.jcc.DB2Driver

dbType Specify the type of database you are running. Enter it in 
all lower case, as shown: 

For Oracle, specify oracle

For Microsoft SQL Server, specify sqlserver

For DB2, specify db2

For an XML datasource, specify xml

folder If using an XML datasource, specify the complete path of 
the folder location for the XML files.

Note: If the source database is a database schema, you 
must set the value of this attribute to null. For example, 
folder="".

Table 6–2 Configuration Deployment Tool Preference Settings

Element Description
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jdbcURL Specify the URL to connect to the database:

If using Oracle, set to: 
jdbc:oracle:thin:@<DatabaseServerHostnam
e/IPaddress>:<TNSListenerPortNumber>:<Da
tabaseSID>.

If using Microsoft SQL Server 2005/2008, set to: 
jdbc:sqlserver://<Database Server 
Hostname>:<Port 
Number>;DatabaseName=<Database name>.

If using DB2, set to: jdbc:db2://<Database 
Server Hostname>:<Port Number>/<Database 
name>.

schema Specify the schema owner as follows: 

If you are using Oracle or DB2 database, and the 
user you specify is different from the Selling and 
Fulfillment Foundation schema owner, specify the 
owner of the Selling and Fulfillment Foundation 
schema.

If you are using Microsoft SQL Server, leave this field 
blank. For example, schema="".

Note: For Oracle and DB2 databases, leave this field 
blank if the schema name is same as the username.

user Specify the user name associated with the database.

<TargetDatabases> Element

For description about Name, className, dbType, folder, jdbcURL, schema, and 
user attributes please refer to the <SourceDatabases> Element Attribute list.

httpurl Only applicable for the target database. Specify a URL 
for the application server whose data cache is to be 
refreshed after data is deployed into the target database. 
Use the syntax: 
http://<hostname/ip-address>:<port-number>/
Application/interop/InteropHttpServlet, 
where hostname, IP-address and port-number are the 
parameters used to connect to the application server. 

httpuser Specify the username associated with the application 
server whose data cache is to be refreshed after data is 
deployed into the target database.

Table 6–2 Configuration Deployment Tool Preference Settings

Element Description
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<SourceTargetPrefs> Element

SourceDatabase Specify the name of the source database.

TargetDatabase Specify the name of the target database.

<Transformations> Element

Tables and Columns that can be added or deleted.

<Table> Element’s 
Name Attribute

Specify the name of the table on which you want to carry 
out the transformation. The syntax and case must match 
the name of the table used in the Selling and Fulfillment 
Foundation ERDs. Custom tables cannot be transformed. 
Choose the Details icon to specify a value. 

Note: If you don’t want to use this field, set the value of 
this field to null. For example, Name="".

<Column> Element’s 
Name Attribute

Specify the name of the column containing the data to 
be transformed. The syntax and case must match the 
name of the column used in the Selling and Fulfillment 
Foundation ERDs. Extended columns can be transformed. 
Choose the Details icon to specify a value. 

Note: If you don’t want to use this field, set the value of 
this field to null. For example, Name="".

<Transform> Element

Define the transformation for this column. For each column, you can define one 
or more transformations. These transformations are applied to data in this 
column in sequential order. You can specify multiple transformations for each 
column, using the delete action to remove the parent element.

Match Specify the pattern to search for in the source data. All 
matching occurrences of this pattern are replaced with 
the value specified in the Replace attribute. Choose the 
Details icon to specify a value. 

Replace Specify the value to replace the pattern with. Choose the 
Details icon to specify a value. 

Table 6–2 Configuration Deployment Tool Preference Settings

Element Description
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XPath Conditional. If the column to be transformed contains 
non-XML data, you do not need to specify this XPath 
attribute. However, some configuration information in 
Selling and Fulfillment Foundation is stored as XML in the 
database. 

If the column to be transformed contains XML data, use 
this attribute to specify the location of the exact attribute 
to be transformed. 

Use the syntax:  
xml:/Configuration/Connection/Host/@IPAddre
ss. Choose the Details icon to specify a value. 

<Ignore> Element

<Table> Element’s 
Name Attribute

Specify any external configuration tables that you do not 
want the tool to deploy from the source to the target. 
Ignoring a table automatically ignores all dependent 
tables as well. 

Note: If you don’t want to use this field, set the value of 
this field to null. For example, Name="".

<AppendOnly> Element

<Table> Element’s 
Name Attribute

Specify configuration table, if any, in which some rows 
maintain data that is external to Selling and Fulfillment 
Foundation. This prevents the data from being deleted 
during deployment. Specify that table and all of its 
dependent tables. 

Note: Rows that are maintained externally should never 
be present in your source database, since this can lead 
to unpredictable results.

Note: If you don’t want to use this field, set the value of 
this field to null. For example, Namer="".

Table 6–2 Configuration Deployment Tool Preference Settings

Element Description
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7
Transforming Elements Using the CDT

When deploying data from one database instance to another, you can 
override the values of certain data elements. For example, if your source 
and target environment network settings (host names, port numbers, 
and IP addresses) are different, the Configuration Deployment Tool can 
transform the settings in order to make them appropriate for the target 
environment.

7.1 Transforming Elements
Transformations are carried out as a pattern match and replace the data 
in the source database before it is deployed into the target.

Example Transformation
For example, consider the following configuration XML in the source 
database: 

<SubFlowConfig> 
  <Link>
    <Properties DeliveryMode=""
     InitialContextFactory="weblogic.jndi.WLInitialContextFactory"
     ProviderURL="t3://localhost:7001" QCFLookup="TEST_AGENT_QCF"
     QName="DefaultAgentQueue" TimeToLive=""/>
   </Link>
</SubFlowConfig>

Note: The match and replace are carried out for the 
complete string literal and no wild card search for 
characters is allowed.
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The target database has values for port number as 7221 and QCFLookup 
as AGENT_QCF, which you do not want overridden by values in the source 
database. To transform these values, specify the values as described in 
Table 7–1.

Using this example, the Transformation tab would look as shown in 
Figure 7–1. 

Table 7–1 Transforming Elements

Element Attribute Value

ProviderURL

Match Specify 7001 (or 0 to find all occurrences of 0).

Replace Specify 7221 (or 2 to replace all occurrences of 
2).

XPath xml:/SubFlowConfig/Link/Properties/@
ProviderURL 

QCFLookup

Match Specify TEST_ to find all occurrences of TEST_.

Replace Leave blank to ensure that TEST_ is removed.

XPath xml:/SubFlowConfig/Link/Properties/@
QCFLookup 
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Figure 7–1 Transformations Example

To transform elements of the configuration data: 

1. From the Deployment Explorer window action bar, choose the  
Preferences icon. 

2. In the Preferences window, select the Transformations tab and fill in 
values, using the information provided in Table 7–1. When you deploy 
data, these transformation values you specify are deployed along with 
configuration data. 

Before you deploy data, you must first perform a database 
comparison as described in Chapter 8, "Comparing Source and Target 
Databases".
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8
Comparing Source and Target Databases

In order to deploy configuration data into production, you must first 
compare the two databases and then deploy your changes.

After completing the comparison, you can perform any of the following 
actions:

Examine any differences, using the instructions in Section 8.2, 
"Examining Database Differences".

Export the report, using the instructions in Section 8.3, "Exporting 
Comparison Results".

Generate a report, using the instructions in Section 8.4, 
"Generating a Report of Differences".

Deploy your changes, using the instructions in Chapter 9, 
"Deploying Your Configuration Data".

8.1 Comparing Data
To compare the source and target databases:

1. From the Deployment Explorer tree, select the data you want to 
compare. 

Note: The CDT considers special characters as data when 
both source and target environment are databases.
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 The available comparison groups are as follows: 

For the entire database, choose the  Selling and Fulfillment 
Foundation Configuration icon. 

For a specific configuration group, choose the  Configuration 
Group icon. 

For a specific driver entity, choose the  Driver Entity icon. 

2. From the Deployment Explorer action bar, choose the  Compare 
icon. The Comparison Results window displays on the top right and 
lists all differences. The Comparison Results Status panel displays on 
the bottom right.

Tip: When you are deploying data for the first time, 
compare the entire database. Compare smaller increments 
only after you are certain that your source and target 
databases have relatively few differences.

Note: If you did not specify the 
CompareOrganizationCode argument as part of the ydk 
command, the CDT prompts you to specify the 
organizations that you are comparing, as explained in 
Section 8.1.1, "Specifying Organizations to Compare". 

Additionally, if you comparing data in a multischema 
deployment, the CDT prompts for a Colony ID, as 
explained in Section 8.1.2, "Comparing Data in a 
Multischema Environment".
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Figure 8–1 Comparison Results Window

 

8.1.1 Specifying Organizations to Compare
If you did not pass the CompareOrganizationCode argument as part of 
the ydk command, the CDT displays the Input pop-up window when you 
choose the  Compare icon in the Deployment Explorer window. The 
Input pop-up window prompts you to specify the organizations that you 
want to compare.

Note: If a table is present in multiple groups or under 
multiple entities, its difference may be counted multiple 
times in the total number.
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Use a comma-delineated format to specify organizations to compare, 
such as Org-1,Org-2. If you click OK without entering an organization, 
the CDT compares all organizations. It is recommended that all 
participating organizations are compared together. For example, if two 
organizations, Org-01 and Org-02, participate with two ship nodes, 
Node-01 and Node-02, you should specify 
Org-1,Org-2,Node-01,Node-02.

8.1.2 Comparing Data in a Multischema Environment
If you are comparing data in a multischema environment, the CDT 
displays a prompt for the Colony ID to compare:

If you click OK without entering a Colony ID, the CDT compares all 
colonies.

When you enter a Colony ID and click OK, the CDT compares data only 
for that colony, which is the set of organizations that belong to the 
colony. If you have other colonies in your configuration schema that you 
want to compare, you must compare each colony separately. For 
example, you must compare Colony_01 and Colony_02 in separate 
comparisons.
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If you are comparing data in a master data schema, CDT displays the 
Input pop-up window instead of displaying a prompt for the Colony ID. 
This is because the master data is the data of an entire colony.

When you enter the name of an organization in the Input pop-up 
window, CDT compares only the data of the organization that belongs to 
the particular colony.

If you click OK without entering an organization in the Input pop-up 
window, CDT compares all the colonies.

8.2 Examining Database Differences
To examine the differences between databases:

1. Choose  to compare the two databases. For more information 
about comparing databases, see Section 8.1, "Comparing Data". 

2. From the Comparison Results tree, expand the corresponding entity 
and select the table that you want to examine.

3. From the Comparison Results action bar, choose . The range of 
possible results are as follows: 

 - The Unchanged icon indicates that an entity contains dependent 
tables that have differences.

 - The Add icon indicates that a record is inserted to the target 
database.

 The Remove icon indicates that a record is deleted from the target 
database. 

 The Modify icon indicates columns that are updated on the target 
database. 

4. Choose an entity’s icon, as described in step 3, to display the Record 
Details window for the entity. The window displays data about the 
entity’s values in the target database. For example, the Record 
Details window for modified data displays the following sections: 

– Top section - displays values that are changed on the target 
database

– Bottom section - displays values that remain the same. 

Figure 8–2 shows the Record Details window for inserted data.
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Figure 8–2 Record Details Window 

5. After examining your data, you may want to generate a report of 
these differences as described in Section 8.4, "Generating a Report of 
Differences". 

8.3 Exporting Comparison Results
You can export the configuration differences for comparison at a later 
time or as a backup for your existing configuration.

To export the comparison results into an XML file:

1. Ensure that you have specified a directory location where the 
comparison report is generated in the Reports Directory field in the 
Settings tab of your Selling and Fulfillment Foundation Configuration 
Deployment Tool Preferences. For more information about specifying 
these preferences settings, see Section 5.3, "Setting Preference 
Settings".

2. From the Comparison Results action bar, choose . From the 
Windows Explorer, browse to the location specified in the Reports 
Directory field.

The Selling and Fulfillment Foundation Configuration Deployment Tool 
automatically creates a subdirectory in this directory. For example, if 
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you have specified D:/reports in the Reports Directory field and 
exported the comparison results at 3:40 pm on May 23, 2008, CDT 
creates the subdirectory as: D:/reports/export20080523154024. 
This new subdirectory contains the ydkexport.xml file, which 
contains the comparison results.

After the import gets completed, you can perform any of the following 
actions:

Examine the differences using the instructions in Section 8.2, 
"Examining Database Differences".

Generate a report of the differences, using the instructions in 
Section 8.4, "Generating a Report of Differences".

Deploy your changes using the instructions in Chapter 9, 
"Deploying Your Configuration Data".

8.4 Generating a Report of Differences
You can generate a report of differences between the source and target 
databases. 

To generate a report of differences:

1. Choose  to ensure that you have specified a reports directory. 
For more information about specifying CDT settings, see Section 5.3, 
"Setting Preference Settings". 

2. Choose  to compare the two databases. For more information 
about comparing databases, see Section 8.1, "Comparing Data". 

3. In the Comparison Results tree, select the Results node. 

4. From the Comparison Results action bar, choose . The Status panel 
displays trace messages that enable you to determine the success of 
the report generation process. The location of the report displays 
along with a message of the successful creation of reports.

5. From the Windows Explorer, browse to your reports directory. Within 
the directory you specified, the Configuration Deployment Tool 
creates a subdirectory named according to the time it was created. 

For example, if you have specified D:/reports as the reports 
directory and generate a report at 3:40 p.m. on May 23, 2008, the 



52   Configuration Deployment Tool Guide

Importing Configuration Differences

CDT creates a subdirectory called 20080523154024 within the 
D:/reports directory. 

This new subdirectory contains the following: 

An index.xml file contains an overall summary of changes as 
displayed on the UI

One XML file for each table that has changes with the details of 
each change 

6. Open the XML files to see the differences. 

If you generate another report, a new directory is created and populated 
with another set of XML files.

8.5 Importing Configuration Differences
You can import configuration differences that are obtained by exporting 
comparison results.

For more information about exporting comparison results, see 
Section 8.3, "Exporting Comparison Results".

To import configuration differences:

1. Run the <INSTALL_DIR>/bin/ydk.cmd script. This script opens a 
Microsoft Windows console and starts the Selling and Fulfillment 
Foundation Development and Deployment WorkBench.

2. From the Selling and Fulfillment Foundation Development and 
Deployment WorkBench menu, choose Tools > Deployment > Import 
Results. The Selling and Fulfillment Foundation Configuration 
Deployment Tool Import dialog box displays.

Note: The Configuration Deployment Tool does not 
support data that contains special characters when 
comparing databases, exporting comparison results or 
importing comparison results.
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Figure 8–3 Import Dialog Box

3. Choose the Target button and enter the values appropriate for the 
Target database. Then choose the Import File and enter the path of 
the file to be imported.

When you are finished, close the dialog box by clicking OK. 

4. After the comparison results are loaded, you can perform any of the 
following actions:

Examine any differences, using instructions as specified in 
Section 8.2, "Examining Database Differences".

Generate a report, using the instructions as specified in 
Section 8.4, "Generating a Report of Differences".

Deploy your changes, using instructions as specified in 
Section 8.5, "Importing Configuration Differences".
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9
Deploying Your Configuration Data

Before deploying configuration data, ensure that you are deploying the 
correct data by comparing the data and examining any differences. 

In addition, ensure that you have addressed rollback issues. Selling and 
Fulfillment Foundation supplies sample backup and rollback scripts. For 
information on these scripts, see Section 11.4, "Data Rollback Scripts". 

9.1 Deploying Configuration Data
To deploy your configuration data:

1. Compare the two databases (by choosing the  Compare icon). For 
this detailed procedure, see Section 8.1, "Comparing Data". 

2. From the Comparison Results tree, select the entities you want to 
deploy. 

Tip: When you deploy data for the first time, deploy the 
entire database. Deploy smaller increments only after 
you are certain that your source and target databases 
have relatively few differences.

Note: When comparing ship nodes, even if a node in the 
source schema does not have the adjustment reason code 
values PACK, SHIP, or RECEIVE, these values will be 
defaulted to the node in the target schema.
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The available options are as follows: 

For the entire database, choose the  Selling and Fulfillment 
Foundation Configuration icon. 

For a specific configuration group, choose the  Configuration 
Group icon. 

For a specific driver entity, choose the  Driver Entity icon. 

For a specific record listed under the driver table, choose the  
icon for that record.

3. From the Comparison Results action bar, choose the  Deploy icon. 

If the deployment succeeds, the Status panel displays a success 
message, the data is committed to your target database, and the 
cache is updated as specified in the httpurl field described in 
Table 5–2. 

If the deployment fails, the Status panel indicates the errors to 
resolve and no data is committed to the target database. 

4. If you have deployed data from the YFS_RESOURCE table, restart your 
application servers in the target environment in order to refresh the 
cache.

9.1.1 Auditing
During the deployment of the configuration data, the audits are 
generated in the target database. These audits can be used for tracking 
changes and rolling back the data. These audits are not deployed from 
the source database, they are generated based on the entity definitions 
located in the <INSTALL_DIR>/repository/entity directory. For more 
information about Generating Audit References for Entities, see the 
Selling and Fulfillment Foundation: Extending the Database Guide

Note: This option is only available if you compared the 
entire database in step 1.
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9.1.2 Driver XML Files
Selling and Fulfillment Foundation provides two driver xml files that are 
used by the CDT to display logical or functional grouping of tables into 
which data is deployed. These files organize the tables in a hierarchical 
manner based upon the functional dependencies among them. The actual 
data deployment is carried out in accordance with this structure or 
hierarchy. The config-db.xml and master-db.xml files are located in the 
<INSTALL_DIR>/databse/cdt/ directory.  

9.1.3 Deploying Your Configuration Data in Command-Line 
Mode

There may be circumstances under which you want to run or schedule 
deployment of configuration data without user interface interaction or 
without viewing the source and target comparison results. 

To accomplish this you can deploy your configuration data in 
command-line mode. When you deploy your data in command-line mode, 
CDT automatically compares the source and target environments and 
then deploys the configuration data.

To deploy configuration data in command-line mode:

1. Set the properties in the <INSTALL_DIR>/bin/cdtshell.cmd file for 
windows (cdtshell.sh for UNIX/Linux) as described in Table 9–1.

Table 9–1 Configuration Deployment Tool Properties

Property Description

SOURCE_DB The logical identifier for the source database.  This value 
corresponds to the Name setting in the 
<SourceDatabases> element in the ydkprefs.xml file.

SOURCE_PASSWORD Optional. If using a database as the source destination 
for data, specify the password for the database instance.

TARGET_DB The logical identifier for the target database.  This value 
corresponds to the Name setting in the 
<TargetDatabases> element in the ydkprefs.xml file.

TARGET_PASSWORD Optional. If using a database for the target destination, 
specify the password for the database instance.
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2. Run the <INSTALL_DIR>/bin/setupfiles.cmd script for windows 
(setupfiles.sh for UNIX/Linux).

3. Run the <INSTALL_DIR>/bin/cdtshell.cmd script for windows 
(cdtshell.sh for UNIX/Linux). 

You can also schedule this script to run at any appropriate time.

You can use the following MODE command line options with CDT:

MODE Deploy—To deploy changes from source to target database. 
The various other options available with this MODE argument are:

– ExportDir <directory>—The specified <directory> will be created, 
and the results of the comparison are stored in that <directory>.

– ExportPassphrase <password>—The specified password will be 
used to encrypt supported Import or Export data when exporting 
results. This is only applicable when ExportDir parameter is 
passed.

– ImportDir <directory>—The specified <directory> should contain 
the exported results. Instead of comparing the source and target 
databases, this export will be loaded. When you pass this 
argument, the source database properties are not used.

– ImportPassphrase <password>—The specified password will be 
used to decrypt data from the import files, and it should match 
the password given to create the export file.

– DoNotSynchronize <Y|N>—If you pass Y, only the comparison the 
is done; nothing is deployed. By default, exported results are 
automatically deployed.

TARGET_HTTP_PASS
WORD

Specify the password of the http user required to refresh 
the cache on the server.

Note: This parameter is not required if there is no cache 
to refresh on the server. 

Table 9–1 Configuration Deployment Tool Properties

Property Description



Deploying Configuration Data

Deploying Your Configuration Data   59

For example, if you want to perform comparison and export the 
comparison results to specific directory. But you do not want to deploy 
those changes, pass the following arguments:

-MODE Deploy -ExportDir C:\CDT\Reports -DoNotSynchronize Y

MODE CDT2IE—To convert the CDT comparison export format to the 
Import or Export file format. The two required parameters that you 
need to pass with this MODE argument are:

– InputFile <Path to the ydkexport.xml file>

– OutputFile <Name of the Import or Export file to write>

For example:

-MODE CDT2IE -InputFile C:\CDT\ydkexport.xml -OutputFile 
NewImportFile.xml

MODE IE2CDT—To convert the Import or Export file format to the CDT 
comparison file format. The two required parameters that you need to 
pass with this MODE argument are:

– InputFile <Name of the Import or Export file to write>

– OutputDir <Path to the directory where the CDT comparison file 
should be stored>

For example:

-MODE IE2CDT -InputFile MyImportFile.xml -OutputDir 
C:\CDT\Reports

MODE LABELDEPLOY—To deploy audit changes between two version 
labels. The two available options with this MODE argument are:

– FromLabel <Label identifier to start from>

– ToLabel <Label identifier to end with>

For example:

-MODE LABELDEPLOY -FromLabel MyLabel1 -ToLabel MyLabel2

Note: if you do not pass the MODE java argument 
explicitly, CDT uses MODE Deploy option as default.
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10
Configuration Data Versioning Tool

This chapter explains how to set up and use the Configuration Data 
Versioning tool. 

10.1 Versioning Tool Overview
Configuration data is an integral part of all implementations. Often, there 
is a need to track changes to an implementation’s configuration. 
Furthermore, if the changes in configuration data are found to be 
inadequate, there is no easy way of rolling back changes to their original 
states.

In an offsite and onsite implementation model, master configuration data 
is maintained onsite, which is where the production environment is 
hosted. When a patch must be applied to the production environment, 
offsite test developers must write instructions regarding any 
configuration data changes for the patch and pass it to the onsite 
configuration manager; that is, certain values of business rules need to 
be changed. The onsite configuration manager has to replicate the 
configuration changes onto the production environment. 

To make it easier to track versions of configuration data or sets of 
changes to configuration data, Selling and Fulfillment Foundation includes 
the Configuration Data Versioning Tool. It enables you to capture 
changes from a source database, compare and deploy them onto a target 
database (this can be the same or a different database). 

The config table must have AuditRequired set to Y and the table name 
must exist in config-db.xml.
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You can create version labels in the Configurator to represent timestamps 
in a time line when changes occur in configuration data. The system can 
then identify any changes in the configuration data between timestamps 
of version labels based on the audit information in the system.

Configuration Data Versioning Tool Features
The Configuration Data Versioning (CDV) Tool can be accessed from the 
Selling and Fulfillment Foundation Development and Deployment 
WorkBench (also known as the "WorkBench").

The Configuration Data Versioning Tool allows you to select different 
version labels from a source database, compare the data and apply them 
to a target database. The system identifies modifications made to the 
source database between two version labels. You can see the details of 
each modification and detect conflicts. These modifications are applied to 
the target database while checking for conflicts. Once all conflicts are 
resolved, you can deploy the changes.

Version label data is stored in the YFS_CONFIG_VERSION_LABEL table. 
The manageConfigVersionLabel API and getConfigVersionLabel API are 
used to manage and search for config version labels.

Note: To enable this functionality the configuration table 
must have AuditRequired flag set to Y. By default, most of 
the configuration tables have AuditRequired flag set to Y.

Note: The CDV Tool supports configuration tables only.  

Note: When configuring the audit purges, if you purge 
the YFS_AUDIT table records from the deployable tables, 
the Configuration Data Versioning Tool will not deploy 
those changes.
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10.1.1 Version Labels Examples
The following table shows two version labels, VersionLabel_1 and 
VersionLabel_2, and some samples of their associated changes and 
timestamps:

You can obtain the changes based on the configured version labels in the 
Sterling Development and Deployment WorkBench, including both 
forward and backward changes. 

10.1.1.1 Forward Changes
These are changes from an earlier version label to a later version label 
(or the latest changes). 

In this case, it can be from VersionLabel_1 to VersionLabel_2 or Version 
Label_1 to current timestamp. This can be used in the scenario where 
users want to capture the certain changes from one system and deploy 
those changes onto another system.

Table 10–1 Version Label Example

Version Label Audited Changes Timestamp

Org1 is created. 5/1/2007 9:00

Org2 is created. 5/1/2007 9:10

VersionLabel_1 5/1/2007 9:20

Org1's DefaultFulfillmentType is updated from "A" to 
"B" 

5/1/2007 9:30

Org1's DefaultFulfillmentType is updated from "B" to 
"C" 

5/1/2007 9:40

Org2 is deleted 5/1/2007 9:50

Org3 is created 5/1/2007 10:00

VersionLabel_2 5/1/2007 10:10

Org4 is created 5/1/2007 10:20

Current Timestamp
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10.1.1.2 Forward Changes Example
Using the Version Labels table as the basis for this example, if the user 
wants to obtain changes from VersionLabel_1 to VersionLabel_2, the 
following changes will be captured to be applied later on another system:

10.1.1.3 Backward Changes
These are changes from the current time to an earlier version label.

The audit data will be translated in the reverse logic as the changes to 
be applied later.

10.1.1.4 Backward Changes Example
Using the Version Labels table as the basis for this example, if a user 
wants to obtain all changes from the current timestamp to 
VersionLabel_1 so that those changes can be used in rolling back all 
changes modified after VersionLabel_1. The following changes will be 
obtained.

10.2 How the Configuration Data Versioning Tool 
Works 

This section describes how to configure preferences (such as a Reports 
Directory) and parameters for resolving conflicts for the Configuration 
Data Versioning.

Changes to be Applied

Update Org1's DefaultFulfillmentType from “A” to “C” 

Delete Org2

Create Org3

Changes to be Applied

Delete Org4

Delete Org3

Create Org2

Update Org1's DefaultFulfillmentType from “C” to “A”
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10.2.1 Setting Up the Configuration Data Versioning Tool
Before you can use the comparison tools, you must create version labels 
for the databases using the Applications Manager. For more information 
about creating configuration version labels, see the Selling and 
Fulfillment Foundation: Application Platform Configuration Guide.

10.2.2 Setting Preferences for Configuration Data 
Versioning Tool

1. Start the Configuration Data Versioning Tool. For more information 
about using the Configuration Data Versioning Tool, see the 
Section 10.3, "Using the Configuration Data Versioning Tool".

2. Select Tools > Configuration Data Version Deployment.

3. The Logon screen displays. Select the names of the desired source 
and target databases, and enter the password for each. Click OK. 

4. The Compare screen displays. Click Preferences.

In the Preferences window, you can define preferences for the 
Configuration Data Versioning tool. For field value descriptions, see 
Table 5–3.

10.2.3 Conflict Handling
You can enable conflict handling by selecting Conflict Handling for 
Version Deployment in Preferences. This is used to prevent overriding 
of any subsequent changes that occur on the target database.

For example, TaxPayerID has changed from “A” to “B” based on the audit 
information on the source database. However, on the target database the 
TaxPayerID has been changed from “A” to “C.” When the change is 
obtained from the source database and compared with the current value 
in the target database, the system will detect that the value is no longer 
“A” and present that to the user for validation.

There are three levels of enforcement: 

Validate Old Values: When enabled, the system will detect conflict 
based on the expected old value of an attribute of a record of the 
obtained changes from the source database vs. the current value of 
the corresponding record in the target database. The details screen 
displays the conflicting attributes.
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Validate Lockid: When enabled, the system detects conflict based on 
the expected Lockid of a record of the obtained changes from the 
source database vs. the current Lockid of the corresponding record in 
the target database. When a conflict is detected, you cannot deploy 
the changes. If this is selected, the following occurs:

– The Details screen will display this highlighted text: Conflicting 
Lockid – Deploy Action is disabled.

– The conflicting attributes with the Expected Old Values will be 
displayed. 

– The Deploy action will be disabled until all conflicts are resolved.

Validate Record Exists Before Delete: When enabled, the system will 
validate the record exists in the target database before it attempts to 
delete it. If the record is not there, the operation will be marked as a 
conflict.

10.3 Using the Configuration Data Versioning 
Tool

This section contains instructions for using the Configuration Data 
Versioning Tool.

To start the Configuration Data Versioning Tool:

1. Start the Selling and Fulfillment Foundation Development and 
Deployment WorkBench. On Microsoft Windows, run the ydk.cmd 
script for Windows (ydk.sh for UNIX/Linux) from the 
<INSTALL_DIR>\bin directory.

Note: Lockid validation is not available for the audit 
records created before the Selling and Fulfillment 
Foundation Release 8.0.
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2. From the Selling and Fulfillment Foundation Development and 
Deployment WorkBench menu, choose Tools > Deployment > 
Configuration Data Version Deployment. This opens the Configuration 
Data Version Tool Logon dialog box.

Figure 10–1 Configuration Data Version Tool Dialog Box

3. Choose the Source button and enter the values appropriate for the 
source database. Then choose the Target button and enter the values 
appropriate for the target database.

When you are finished, close the dialog box. The values you specified 
are saved automatically and persist from one session to the next.

In the Source database and Target database windows, specify the 
applicable values as described in Table 10–2.

Note: The Windows console displays WorkBench startup 
information. Do not close the console while the WorkBench 
is running. Closing the console closes the tool, and your 
work is lost.

Note: If you change the name of either source or target 
database, the transformation settings are lost. To get back 
your old transformation settings, revert to the old source 
and target database name.
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Table 10–2 Configuration Deployment Tool Logon Dialog Box

Field Detail

Name Specify a logical database identifier. For the source, specify the 
database you want to copy data from. For the target, specify 
the database to write the data to. 

className Specify the class name of your database driver as follows: 

If using Oracle, set to:  oracle.jdbc.OracleDriver

If using Microsoft SQL Server 2005/2008, set to: 
com.microsoft.sqlserver.jdbc.SQLServerDriver

If using DB2, set to: com.ibm.db2.jcc.DB2Driver

jdbcURL Specify the URL to connect to the database:

If using Oracle, set to: 
jdbc:oracle:thin:@<DatabaseServerHostname/IP
address><TNSListenerPortNumber>:<DatabaseSID
>.

If using Microsoft SQL Server 2005/2008, set to: 
jdbc:sqlserver://<Database Server 
Hostname>:<Port 
Number>;DatabaseName=<Database name>.

If using DB2, set to: jdbc:db2://<Database Server 
Hostname>:<Port Number>/<Database name>.

dbType Specify the type of database you are running. Enter it in all 
lower case, as shown: 

For Oracle, specify oracle

For Microsoft SQL Server, specify sqlserver

For DB2, specify db2

For an XML datasource, specify xml

folder If using an XML datasource, specify the complete path of the 
folder location for the XML files.

httpurl Only applicable for the target database. Specify a URL for the 
application server whose data cache is to be refreshed after 
data is deployed into the target database. Use the syntax: 
http://<hostname/ip-address>:<port-number>/Appl
ication/interop/InteropHttpServlet, where 
hostname, IP-address and port-number are the parameters 
used to connect to the application server. 
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4. In the Logon dialog box, enter the passwords associated with the 
user names and Click OK.

5. The Compare screen displays. Select a From Version Label and a 
To Version Label and click OK.

The system compares the two database versions. Once the comparison is 
complete, the system displays the Comparison Results screen, as shown 
in Figure 10–2.

schema Specify the schema owner as follows: 

If you are using Oracle or DB2 database, and the user you 
specify is different from the Selling and Fulfillment 
Foundation schema owner, specify the owner of the Selling 
and Fulfillment Foundation schema. 

If you are using Microsoft SQL Server, leave this blank.

user Specify the user name associated with the database.

Note: Use the Applications Manager to create Version 
Labels. For more information on how to create Version 
Labels, see the Selling and Fulfillment Foundation: 
Application Platform Configuration Guide.

Table 10–2 Configuration Deployment Tool Logon Dialog Box

Field Detail
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Figure 10–2 Comparison Results Screen

Note that the results are grouped by table name onscreen. 

6. To see the details for any record included in the results, right-click 
and select Details. 
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Figure 10–3 Conflict Details Screen

Table 10–3 Configuration Deployment Versioning Tool Conflict Details

Field Detail

The first row displays the name of the entity which contains the conflict (for 
example, YFS_ORGANIZATION), type of the conflict (for example, Record has 
been modified), and user key (for example, DEFAULT).

Name Displays the name of the attribute whose values 
caused the conflict.

Expected Old Value Displays the old value that is expected in the target 
database.

Actual Old Value Displays the old value that actually exists in the target 
database.

New Value Displays the new value that is obtained due to the 
change in the source database.

Previous Click this button to view the previous record.
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There are three types of changes that can be displayed:

Modifications: The Record Details screen displays with a list of 
changed and unchanged attributes. For changed attributes, the 
old value and the new value will be displayed. (The old value is 
the existing value on the target database; new value is the value 
of the obtained change from the source database.)

Insertions: The Record Details screen displays with a list of 
attributes and their values to be inserted. 

Deletions: The Record Details screen displays with a list of 
attributes of the entity. 

You can scroll through the records by using the Previous and Next 
buttons. When you are done reviewing the details for a record, click 
Close.

10.3.1 Exporting Results
Before resolving conflicts in the database, you must export the changes 
to a file so that they can be later deployed on another environment by 
using the Export Results option. Exporting results for research is only a 
"must" when conflicts do exist. If there are no conflicts, exporting results 
is not required.

To export the results to a file:

1. Start the Sterling Development and Deployment WorkBench.

2. Select Tools > Configuration Data Version Deployment.

3. The Logon screen displays. Select the names of the desired source 
and target databases, and enter the password for each. Click OK. 

Next Click this button to view the next record.

Close Click this button to close the Conflict Details window.

Changed Displays the name of the changed attribute along with 
it’s old value and new value.

Unchanged Displays the name of the unchanged attribute along 
with it’s existing value.

Table 10–3 Configuration Deployment Versioning Tool Conflict Details

Field Detail
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4. The Compare screen displays. Select a From Version Label and a 
To Version Label and click OK.

5. From the Comparison Results action bar, choose the  Deploy icon. 

This option does the following:

Creates a new folder under the Reports Directory configured in the 
Preferences with the naming convention as 
“export_<FromVersionLabelID>_<ToVersionLabelID>_<CurrentTS>” 

Creates a version audit file named as ydkversionexport.xml file.

10.3.2 Resolving Conflicts
The database conflicts can only be resolved by editing the version audit 
file ydkversionexport.xml. The ydkversionexport.xml file contains all 
the changes that are applied to the system. Any detected conflict is 
described within a <Conflict> element. The <Conflict> element contains 
the information such as conflict type and conflict description.

To resolve conflicts:

1. Export the results to the ydkversionexport.xml file (if not already 
done). For more information about exporting results, see 
Section 10.3.1, "Exporting Results".

2. Open the ydkversionexport.xml file and search for the <Conflict> 
element to find out the type of conflict. The CDV Tool supports 
following types of conflict:

RECORD_ALREADY_EXISTS

RECORD_DOES_NOT_EXIST

RECORD_CHANGED

Below is a sample <Conflict> element entry from the 
ydkversionexport.xml file:

<Conflict ConflictDescription="Record does not exist" 
ConflictType="RECORD_DOES_NOT_EXIST"/>
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Resolving RECORD_ALREADY_EXISTS type conflict
This type of conflict happens when CDV tries to perform an Insert 
operation on a record which already exists in the database. You can 
resolve this type of conflict in any of the following ways:

Remove the entire <Audit> element to suppress the change.

Modify the <Audit> element and make it an Update operation 
instead of an Insert operation. This can be done by searching for 
the FoundOldValue attribute within the <ConflictAttribute> 
element and setting it to match the value mentioned in the 
<OldValue> attribute within the <Audit> element. After this, 
change the value of the Operation attribute within the <Audit> 
element from Insert to Update.

Resolving RECORD_DOES_NOT_EXIST type conflict
This type of conflict happens when CDV tries to perform an Delete or 
Update operation on a record which does not exist in the database. You 
can resolve this type of conflict in any of the following ways:

Remove the entire <Audit> element to suppress the change.

Create the expected record in the target database. This can be 
done with the help of Selling and Fulfillment Foundation UI or API, 
or running the CDT.

Resolving RECORD_CHANGED type conflict
This type of conflict happens when CDV tries to perform an Update 
operation on a record whose value has already changed in the database. 
You can resolve this type of conflict in any of the following ways:

Remove the entire <Audit> element to suppress the change.

Create or modify the value of OldValue attribute to match the 
value of FoundOldValue attribute within the <ConflictAttribute> 
element and change the value of NewValue attribute if you want 
to change the value.

Below is a sample <Audit> element entry from the 
ydkversionexport.xml file:

<Audit AuditKey="20081219134644594514" Operation="Insert" 
TableKey="20081219134644594512" TableName="YFS_QUEUE_SUBSCRIPTION"> 
<AuditDetail AuditType="QueueSubscription"> 
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<IDs> 
<ID DataType="class java.lang.String" Name="QueueKey" 
Value="20081110160649488514"/> 
</IDs> 
<Attributes> 
<Attribute DataType="class com.yantra.yfc.date.YTimestamp" 
Name="Createts" NewValue="20081219134644"/> 
<Attribute DataType="class com.yantra.yfc.date.YTimestamp" 
Name="Modifyts" NewValue="20081219134644"/> 
<Attribute DataType="class java.lang.String" Name="UserKey" 
NewValue="20051121111734438480"/> 
</Attributes> 
</AuditDetail> 
<Conflict ConflictDescription="Record already exists" 
ConflictType="RECORD_ALREADY_EXISTS"> 
<ConflictAttribute ExpectedOldValue="" 
FoundOldValue="20081219134644594512" 
Name="QueueSubscriptionKey" NewValue="20081219134644594512"/> 
<ConflictAttribute ExpectedOldValue="" FoundOldValue="" 
Name="Createts" NewValue="2008-12-19T13:46:44+00:00"/> 
<ConflictAttribute ExpectedOldValue="" FoundOldValue="" 
Name="Modifyts" NewValue="2008-12-19T13:46:44+00:00"/> 
</Conflict> 
</Audit> 

10.3.3 Importing Version Audit File
After resolving the conflicts, you can import the version audit file 
(ydkversionexport.xml).

To import the Version Audit File:

1. Start the Sterling Development and Deployment WorkBench.

2. Select Tools > Deployment > Import Version Audits. 

3. The Logon screen displays. Select the name of the target database, 
and enter the password for the target database. Browse to the 
version audit file (ydkversionexport.xml), and click OK. 

10.3.4 Deploying Database Changes
Before you can deploy changes from one database to another, you must 
first verify whether there are conflicts. If there are conflicts, you must 
export the results to a file in order to research and resolve conflicts. 
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Once the conflicts have been resolved, you can re-import the version 
audit file (ydkversionexport.xml) and then deploy the changes to the 
target database. For more information about resolving conflicts, see 
Section 10.3.2, "Resolving Conflicts".

To deploy the database changes:

1. Start the Sterling Development and Deployment WorkBench.

2. Select Tools > Configuration Data Version Deployment. The Logon 
screen displays. 

3. Select the names of the source and target databases, and enter the 
password for each. Click OK. The Compare screen displays. 

4. Select a From Version Label and a To Version Label, and click 
OK.

5. From the Comparison Results action bar, choose the  Deploy icon. 
The Input window displays.

6. In Enter a label for this deployment field, enter the label number from 
which you want to deploy the configuration data.

If the deployment succeeds, the Status panel displays a success 
message. The data is committed to your target database, and the 
cache is updated as specified in the httpurl field described in 
Table 5–2. 

If the deployment fails, the Status panel specifies the errors to 
resolve, and data is not committed to the target database. 

10.3.5 Rolling Back Changes
You can rollback changes to a given version label. The CDV Tool audits all 
the records from a label to the current timestamp, figures out the 
changes, reverses those changes, and applies it back to the database.

To rollback changes to a particular label:

Note: In a multischema environment, ensure that you 
run the Colony Map Synchronizer agent after deploying 
configuration data, as described in the "Time-Triggered 
Transaction Reference" appendix in the Sterling Distributed 
Order Management: Configuration Guide.  
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1. Start the Sterling Development and Deployment WorkBench.

2. Select Tools > Deployment > Rollback Data To Version Label.

3. Select the name of the database and enter the password. Click OK.

4. Select a To Version Label, and click OK. The Compare screen 
displays.

5. From the Comparison Results action bar, choose the  Deploy icon. 
The Input window displays.

6. In Enter a label for this deployment field, enter the label number from 
which you want to deploy the configuration data.

If the deployment succeeds, the Status panel displays a success 
message. The data is committed to your target database, and the 
cache is updated as specified in the httpurl field described in 
Table 5–2. 

If the deployment fails, the Status panel specifies the errors to 
resolve, and data is not committed to the target database.
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11
Troubleshooting

During operations, the Configuration Deployment Tool displays messages 
in the Status panel that enable you to understand the status of each 
operation. These messages can be classified as: 

Status

Warnings

Unexpected errors

The following section describes various messages that you may 
encounter and any relevant corrective actions you should take.

11.1 Messages
While using the Configuration Deployment Tool, you may encounter 
either informational messages or warning messages. These message 
types are described below. 

11.1.1 Informational Messages
Informational messages represent the status of the operation being 
performed. These messages are displayed in the default color (typically 
black) in the Status panel. Examples of informational messages include: 

Refreshing database cache

Deployment operation started

Reading table YFS_ORGANIZATION 
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11.1.2 Warning Messages
Warning messages typically require corrective action. They are displayed 
in red on the Status panel. CDT may produce the warning messages 
described in this section. 

WARNING - FK check failed for table <name> to <name2>
This warning message typically indicates that the configuration data that 
you are trying to deploy causes inconsistent data in the target database.

To analyze and correct this problem: 

1. Determine the size of the data set you are deploying. This error 
typically occurs when trying to deploy a very small set of data, such 
as only a driver entity or a configuration group. For example, when 
deploying a pipeline, this error results if the document type to which 
the pipeline belongs has not been picked for deployment. 

Try resolving this error by selecting a larger set to deploy. For 
example, instead of deploying a record, deploy the entire group, if 
possible.

2. If you still encounter this error for a group or you must only deploy a 
particular record, try synchronizing the foreign table before deploying 
the data. 

3. Occasionally, inconsistent data in the source database causes this 
error. If this is the case, you must correct the source of the 
inconsistency before you proceed.

WARNING - Cache Refresh Failed
This error indicates that CDT was unable to inform the application server 
cluster on the target environment about the newly deployed 
configuration changes. The reason the cache refresh failed is displayed 
on the Status panel. 

To analyze and correct this problem: 

1. Verify the URL specified in the httpurl field for the target database. 
The httpurl is accessible from the Logon dialog box. Ensure that the 
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httpurl points to a running instance of the application server and 
has the following format:

http://<hostname/ip-address>:<port-number>/smcfs/interop/In
teropHttpServlet where hostname, ip-address and port-number are 
the parameters used to connect to the application server.

2. If your target environment is not running, no action is required. 
Selling and Fulfillment Foundation automatically reads the latest 
configuration data when it is started.

3. If the target environment is running, you must manually drop the 
stale database cache using the Selling and Fulfillment Foundation 
System Administration Console. Not performing this step may result 
in Selling and Fulfillment Foundation not recognizing the changed 
configuration.

WARNING - The program detected a few abandoned records 
in the target database.
In most cases, the abandoned records are harmless and do not lead to 
incorrect operation of Selling and Fulfillment Foundation. By default, the 
CDT leaves them untouched. 

This warning typically occurs as a result of the following circumstances 
which are described in detail in Section 2.3, "Externally Maintained 
Configuration Data". 

When the CDT determines that records do not belong to a valid driver 
entity (for example, a pipeline for a process type that no longer 
exists).

When the CDT has been configured to ignore certain tables without 
ignoring all dependent tables.

To analyze and correct this problem: 

1. Add the -DShowAbandoned=Y Java parameter to the ydk.cmd script. 

2. Run the ydk.cmd script. If the CDT finds abandoned records, it 
dynamically creates a group called "Abandoned Records" and displays 
them in the Comparison Results window. 

3. Examine these records, and then either ignore them or delete them 
from the target.

4. Selling and Fulfillment Foundation: Properties Guide.
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11.2 Unexpected Errors
Depending on the severity, messages about unexpected errors are 
displayed in either of the following places: 

In the CDT Status panel (in red)

In the Microsoft Windows console used to launch the Configuration 
Deployment Tool

To analyze and correct these errors: 

If the error indicates an out-of-memory condition, try your previous 
operation with a smaller set of data.

Verify that your system specifications comply with the 
recommendations described in the System Requirements chapter of 
the Selling and Fulfillment Foundation: Installation Guide.

To increase the memory available for the Configuration Deployment 
Tool, edit the <INSTALL_DIR>/bin/tmp.cmd file and set the -ms 
argument value to a higher value. By default, in the tmp.cmd file the 
HEAP_FLAGS Java parameter is set as following.

set HEAP_FLAGS=-Xms768m -Xmx768m

For example, if you were comparing the complete configuration, try 
comparing one group at a time. The same is true for the deployment 
operation.

In other cases, the underlying error and detailed trace are displayed. 
This may point to an incomplete or faulty installation or incorrectly 
specified runtime parameters.

11.3 Exceptions while Exporting with 
cdtshell.cmd/.sh Scripts

The cdtshell.cmd (or .sh) scripts throw a 
java.lang.StringIndexOutOfBoundsException when exporting 
configuration data using the CDT with the database as SOURCE_DB and 
the XML file as TARGET_DB.

To analyze and correct this exception:

Verify that the ExportDir and the folder location of the XML files are not 
the same location.
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11.4 Data Rollback Scripts
Before deploying data from a staging to a production environment, it is 
recommended to take a snapshot of your production configuration data. 
This snapshot enables you to perform a rollback of the deployment 
operation in case of failure. Selling and Fulfillment Foundation provides 
the following rollback scripts: 

Backup script - Creates multiple files containing data from the Selling 
and Fulfillment Foundation configuration data.

Restore script - Uses the files created by the backup scripts to restore 
the Selling and Fulfillment Foundation configuration to a previously 
known good state.

The <INSTALL_DIR>/bin/backupScriptGen.xml script generates backup 
and restore scripts. For more information about running the data rollback 
scripts, see the Selling and Fulfillment Foundation: Installation Guide.
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